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1 Introduction 

1.1 What is MCM? 
Morpheus, Control, and Monitoring (MCM) is the successor to Pro-Bel’s original ‘Procion' 
product range.  Legacy documents, directories, and file paths may still refer to Procion and 
P2 and in context are still valid.  Procion was a family of PC based applications designed to 
control and monitor a range of broadcast hardware, which included router control, video 
and audio monitoring, GPI triggering and event scheduling. Procion’s success was due to 
its intuitive graphical interface, ideal for touch-screens, its networking capability and the 
scalability and range of the product. Unfortunately, Procion was restricted to the Microsoft 
Windows for Workgroups 3.11 operating system, and has therefore become effectively 
obsolete. MCM aims to surpass the capabilities of Procion by using the advanced 
development tools and working environment offered by the Windows XP operating system. 
Features of the MCM system include: 

• Full integration with Pro-Bel’s Aurora, Nebula, or Freeway router controller 

• VTR control 

• Sophisticated designer using Microsoft editing conventions 

• User definable buttons and graphics 

• Local Area Network support 

• Video and Audio monitoring 

• TX Master Control plasma screen emulation 

• Wide Area Network support 

• Event scheduling 

• GPI Support 

• Media Browsing 

• Web based router control 

1.2 MCM router control 
The MCM router control product will be shipped with a 'General Remote' driver, which will 
allow it to communicate directly with an Aurora or Nebula router controller, and therefore 
control any routers included in the Aurora or Nebula database.  
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1.2.1 General Remote Protocol (SW-P-08) 
'General Remote' refers to the protocol that Pro-Bel use to provide control and status of a 
system of routing matrices. Physically, the protocol uses a serial interface running at 38400 
BAUD (38400,8,N, 1) on a 9 pin ‘D type’ connector, this provides real-time control over long 
cable runs with a high tolerance to external interference. The PC running the MCM General 
Remote driver must have such a port available, usually by means of an external RS232 to 
RS422 converter, or an internal PC I/O card, Section 2.1 details these requirements. 

The Pro-Bel Aurora controller has a minimum of two General Remote ports available, any 
of which may connect to the MCM computer running the General Remote driver. The Pro-
Bel Nebula controller is the integrated control system currently shipped with Sirius, 
Freeway, Halo or Axis routers.  Routers that use the earlier Freeway or Routers Windows 
Editor can also be integrated for MCM control.  All of these have 2 configurable serial ports, 
either of which may be configured for General Remote protocol. MCM uses this protocol 
both to set routes and receive 'connected' messages for routes set by other controllers. 

1.2.2 The router control database 
Any router control system needs a ‘database’ of information detailing the names and 
grouping of all sources and destinations, and also the configuration of all hardware control 
panels and under-monitor-displays. This database is critical to the operation of the system, 
and so it resides in ‘non-volatile’, i.e. battery-backed-up memory, in the Aurora or Nebula 
controller, older Freeway/Axis controller and is given the name ‘CURR_SYS’.  All systems 
have database editor software available for editing the database, and if the editor PC has 
ever been used ‘on-line’ with the controller, it will also have a copy of the CURR_SYS 
database on it’s hard drive. 

This database is also critical to the MCM user, since information from this database will be 
used to design the router control panels and to control the system. 

A system of routers will be logically grouped into matrices and levels, Aurora has an upper 
limit of 20 matrices each of 16 levels, and Nebula or Freeway/Axis has 1 matrix of 8 levels. 
However the MCM user does not need knowledge of these numbers since they will have 
direct access to the database, and can therefore use the source and destination names 
assigned in the database.  

The MCM user must understand the meaning of source and destination associations, as 
used in the database editor, and these are described in the following sections. 

1.2.3 Source Associations 
A source association is a combination of input signals, across multiple levels that are 
required to be routed together. A typical example would be that the video, audio and control 



MCM User Guide 

 
 8                                                                                                          Issue 1 

signals for a VTR usually need to be routed at the same time in order to simplify the system 
operation for a user. In a multi-level system, the user must define the source associations, 
at least for all the primary level inputs. The primary level is level 1, typically the video level. 
So, for a multi-level system with a 32 source primary level, there must be at least 32 source 
associations, and these are referred to as the ‘standard associations’. The source names 
and associations are defined in the Aurora or Nebula database, as follows: 

 

 

A source association is usually identified by the name of the source on the primary level, 
however, in the above example, the Aurora editor has been configured to display source 
‘association names’ as well. This makes the system more flexible to the user, since any 8 
character name may be applied to any combination of sources, including ‘special 
associations’, as described in the next paragraph. The MCM user may also make the 
choice of using source names or source association names, providing the Aurora database 
being accessed is also configured to do so, as described in Chapter 3. Note that source 
association names are not an option in the Nebula database editor. 

As well as standard associations, some ‘special associations’ may have been assigned. 
These can consist of any sources on any levels to be associated together, including those 
that have no primary level source. A typical example of this would be an audio-only source, 
such as a DAT machine, as follows: 



MCM User Guide  

 
 HU-MCM  9 

 

If source association names are not being used, special associations are identified by their 
‘index number’. 

1.2.4 Destination Associations 
A destination association describes how equipment is connected to the outputs of a routing 
system. This is particularly important in a multi-level system where a piece of equipment 
may take feeds from more than one level. 

Destinations associations have the following properties: 

• Feeds from other levels to that equipment are defined in the association 

• If equipment has no connection on the primary level, it must use a ‘special 
association’ 

• Special associations are those beyond the maximum primary output number 

These are examples of standard destination associations in an Aurora or Nebula database: 
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1.2.5 Routing using Associations 
The object of programming source and destination associations into the database is to 
make routing a simple activity on a multi-level system. Whenever a source is routed to a 
destination using any type of control panel, it is in fact the associations that are being 
routed, meaning that if the system has 8 levels of routing, up to 8 routes will be made 
simultaneously by a single ‘take’ operation. 

1.2.6 Married and unmarried routes 
When a standard source association is routed to a standard destination association, the 
resulting route is known as being ‘married’, assuming all routes are made successfully. If a 
special association is involved in any routing, the result will be ‘unmarried’. Some hardware 
control panels will indicate an unmarried route by illuminating a yellow LED, in MCM 
unmarried routes may be indicated by a special graphical ‘tally’. Unmarried routes may be 
created or displayed using ‘level’ buttons on a MCM panel. 
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1.3 The router control components 
There are several essential software components required to design and run an MCM 
router control system, as follows: 

1.3.1 MCM Designer 
 

 

This is the software tool for designing and testing control panels. Router control panels 
cannot be designed unless an Aurora or Nebula database is available and open, either 
using the Router Database Driver (see Section 1.3.4), or locally through the Libraries tool 
bar. The same database may be used by any MCM Designer running on the same Local 
Area Network by connecting to the Router Database Driver at a known IP address. 

The configuration and use of this application is described in later sections of this manual. 
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1.3.2 MCM Control Station 
 

 

This is the application on which the MCM router control panels run. Therefore, this must be 
installed on every PC, or ‘client’, in the MCM control system. This software relies on the 
presence of a Licence Manager running on the same network, which itself limits the 
number of MCM Control Stations allowed at any time.  
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1.3.3 General Remote Driver 
 

 

This is the channel of communication between the MCM Control Station(s) and the Aurora 
or Nebula controller. The application must run on the PC that connects to the Aurora or 
Nebula controller via its serial port. 
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1.3.4 Router Database Driver 

 

This application is used to make an Aurora or Nebula database file available to all users of 
the MCM Designer and MCM Control Stations wherever they are on the network. Every 
user has the option of using a local database or the database opened in the Router 
Database Driver, the advantage of using the driver database is that all users will be 
synchronised with the same data. 

In principle, this application can run on any PC in the network, but in practice it is easier to 
locate it where the database files are stored. If an Aurora or Nebula editor exists on the 
system, this will be an ideal location for the Router Database Driver. 
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1.3.5 Licence Manager 

 

The Licence Manager can be regarded as the ‘server’ to which all MCM Control Station and 
General Remote driver ‘clients’ connect. This application requires a minimum of two 
Licence Codes and Keys, one for the Control Stations, and one for the General Remote 
Driver. Additional licences may exist for additional features such as ‘advanced’ router 
control clients and for VTR control. The number of allowed connections is also embedded 
in the licence code, according to the licence purchased with the product.  

The user does not have to buy a full licence in order to use any of the MCM components 
since ‘trial’ licences are also available. The user may enter trial licence codes into the 
Licence Manager and operate the system for a period of 30 days. Trial licences may not be 
re-used, and warnings will be issued every time a Control Station is started up. 

1.3.6 System Driver 

 

This application allows Control Stations to communicate with each other over a TCP/IP 
network in order to support panel locking. Panel Locking is a feature, which gives MCM 
administrators the ability to remotely enable other users locked control panels. 
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1.3.7 An example MCM router control system 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.4 MCM and the Aurora database editor 
Users of the MCM router control software are likely to be already familiar with the Aurora 
database editor, and will be interested in how these two can co-exist on the same PC. Both 
MCM and the Aurora editor are required to connect to the Aurora controller, although the 
editor may only occasionally need to be ‘on-line’. If this is the case, then the user must 
consider the following: 

• The Aurora ‘REMOTE 1’ port also supports the on-line editor 

• The REMOTE ports can only be RS422 

• The REMOTE port always connects to the Active processor 

• Using the Aurora editor on REMOTE 1 will only edit the Active database 

General Remote driver, 
Licence manager, MCM 
Control Station, Router 

Database driver, System 
Driver, MCM Designer 

Aurora controller or Master 
Sirius, Freeway, Halo or 

Axis router Hardware control panels on Multi-drop bus 

General Remote port 

MCM Control Station,       
MCM Designer (optional) 

 

MCM Control Station,          
MCM Designer (optional) 

 

All PCs on TCP/IP network 
RS422 link 
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• Loading a database into the Active controller will disable the control system 
for the duration of the download 

• The Aurora CONFIG A and CONFIG B ports are hard wired to the A and B 
processors respectively 

• The CONFIG ports can be jumper configured as RS232 or RS422 

• The CONFIG ports support the editor AND General Remote protocol 

• Only one CONFIG port will ever be connected to the active processor 

In summary, the user could use the RS232 port on their PC for running the Editor or MCM, 
but with no auto-changeover mechanism. Or, the user could use an RS422 port on their PC 
for running the Editor or MCM, but must be aware that any editing will always effect the 
Active database. 

Ideally, different PCs or different PC serial ports should be used in such an environment.  

1.5 MCM and the Nebula database editor 
If the user requires a Nebula database editor and a MCM General Remote driver to run on 
the same PC, this can only be achieved by using 2 PC COM ports. This is because any 
router system using the Nebula controller has independent editor and control ports. The 
Nebula editor port is always RS232, and does not support General Remote protocol, and 
the ports labelled ‘RS485’ on the router must be configured for General Remote protocol, 
which forces the port into RS422 mode. The RS485 port configuration is either performed 
through the Nebula editor if a ‘configured’ database is selected, or via a control card switch 
setting if a ‘fixed’ database is selected. The user must refer to the Nebula user guide for full 
configuration details. 

1.6 MCM and the earlier Freeway/Router 
editor 
As with the Nebula editor above, the Freeway and Router editors should be configured for 
General Remote Protocol on either of the RS485 ports.  The user must refer to the relevant 
Freeway or Router editor manuals for full configuration details 
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2 Installation and configuration 

2.1 System requirements 
The primary requirement for running MCM router control software is that a General Remote 
port is available on the system Aurora or Nebula Controller. See Section 1.4 and 1.5 of this 
manual. The pin out for these ports is as follows: 

pin function 

1 Chassis 

2 TX- 

3 RX+ 

4 Ground 

5 Not connected 

6 Ground 

7 TX+ 

8 RX- 

9 chassis 

The specification for this RS422 port is as follows: 

• 38400 BAUD 

• 8 data bits 

• 1 stop bit 

• no parity 

The PC running the General Remote driver software must therefore have a corresponding 
RS422 port available. This might be achieved in one of two ways: 

• using an external RS232/RS422 converter connected to the PCs COM port 

• using an internal RS422 PC I/O card 

For either method, a connecting cable will be required, if necessary with appropriate pin 
swapping. 
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PCs running very simple control panels must comply with the following minimum 
specification: 

• Pentium 2, 450 MHz, 128Mb RAM 

• CD ROM drive 

• 30Mb HDD space 

• Windows 2000 or XP operating system 

• 100 Base T Ethernet adapter supporting fixed IP addresses (if using multiple 
workstations) 

However, complex panels configurations comprising hundreds of buttons and tallies within 
multiple canvases require the following recommended specification: 

• Pentium 4, 2 GHz, 512Mb RAM 

• CD ROM drive 

• AGP 4X graphics card with 32Mb RAM 

• 30Mb HDD space 

• Windows 2000 or XP operating system 

• 100 Base T Ethernet adapter supporting fixed IP addresses (if using multiple 
workstations) 

2.2 Installation from a CD ROM 
The MCM software is supplied with an ‘install wizard’, so that all the user must do is locate 
the ‘setup.exe’ file in the root of the CDs directory, using Windows Explorer, and execute 
(double click) it. 

2.2.1 The MCM Install Wizard 
MCM is the successor to Pro-Bel’s original ‘Procion' product range.  Legacy documents, 
directories, and file paths may still refer to Procion and P2 and in context are still valid. 
MCM is normally installed from an Installation CD.  To view the files click on My Computer 
and select the CD Drive.  A screen grab of the files is shown below: - 
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The CD contains the following folders, documents and programs: - 

Install 

Licence Manager 

P2TimedListClient 

P2TimedListServer 

P2WebSetup 

Redist 

Release Notes 

Setup.exe 

SW-RN-707 Issue xx.doc 

Versions may vary with publication date. 

 

Installation 

Before installing you should read documents “Release Notes” and “SW-RN-707”.  These 
contain the latest information. 

We strongly recommend that the Setup.exe install wizard be used to install the program(s). 

The following information is correct at the time of printing, always check for updates. 
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2.2.2 A Step-by-Step View of the Installation Wizard 
 

Close all existing programs. 

Insert Installation CD. 

Go to My Computer and select the installation CD. 

View the files. 

Double click Setup.exe 

The Setup Wizard should start-up. 

This is the main wizard start-up screen 

 

 

Figure 1: Main Installation Menu 
 

All the programs are installed from this menu.  You must follow the 3-Step installation 
sequence to ensure correct installation. 
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2.2.3 MCM Installation Step 1 – Install MCM 
Click on Install MCM button from the main installation menu. 

 

 

Figure 2: MCM Setup Welcome Screen 

 

This is the MCM Setup Welcome Screen.  It is strongly recommended that you exit all 
Windows programs before running this Setup program.  Click Next to continue. 
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Figure 3: MCM Software Licence Agreement 

 

The Software License Agreement will now be displayed.  You must accept this Software 
Licence Agreement if you wish to install the software.  Click “Yes” to accept and commence 
installation.  Click “No” if you do not accept the Licence Agreement and wish to terminate 
the installation.  Click “Back” if you need to review the previous screen.  
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Figure 4: Destination Folder 

Set-up will install MCM in the default folder.  To install to a different folder, click “Browse” and 
select another folder.  If you wish to abort the installation click “Cancel” to exit set-up 

 

Figure 5: Selecting Program Folder 



MCM User Guide  

 
 HU-MCM  25 

 
 

Set-up will add program icons to the Program Folder.  You can either select the default, type 
a new folder name, or select from the existing folder list.  Click “Next” to continue. 

 
 

 

Figure 6:Installation Succeeded Confirmation Screen 
 

When the program has installed correctly, the following confirmation screen will appear. 

 
 

Click OK to return to the main installation menu.  See Figure 1. 

 

2.2.4 MCM Installation Step 2 – Installing Licence Manager. 
 

You must install the Licence Manager to use MCM.  If you are running multiple MCM 
(Procion) Clients, you only need to install Licence Manager on one PC on your network. 
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Figure 7: Licence Manager Set-up Welcome Screen 

 

Again it is strongly recommended that you exit all Window programs before running this 
set-up program. 

Click “Next” to commence the start-up. 
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Figure 8: Software License Agreement 
 

The Software License Agreement will now be displayed.  You must accept this agreement 
to install the Licence Manager.  If you agree click “Yes”. 
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Figure 9: Choosing Destination Folder 

 
Set-up will install the Licence Manager in the default folder.  To install to a different folder, click 
“Browse” and select another folder.  If you wish to abort the installation click “Cancel” to exit set-
up. 
 

 
Figure 10: Select Program Folder 
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Set-up will add program icons to the Program Folder.  You can either select the default, type a 
new folder name, or select from the existing folder list.  Click “Next” to continue. 
 

2.2.5 MCM Installation Step 3 
 

After completing steps 1 and 2, you will be returned to the main installation menu for step 3 
options. 

 

Step 3 allows the installation of the following options: - 

• MCM Web Server Application 

• MCM Web Pages 

• MCM Timed List Server 

• MCM Timed List Client 

Note Licences will normally be required. 

 
 
WARNING 

BEFORE COMMENCING STEP 3 YOU MUST READ THIS SECTION 

 

The web-based applications require the installation of IIS (Internet Information Services) 
and .NET Framework to be actively installed.  This section will guide you through the 
process. 

Checking for IIS 

Step1: Check IIS (Internet Information Services) is installed on the PC used to host the web 
pages 

The PC that will be hosting the web pages must have a web server installed and running. If 
this is a Windows XP or Windows Server PC the web server software is called IIS (Internet 
Information Services). This is not installed by default on a Windows XP PC. To check 
whether it is installed on your PC open “Control Panel”, select “Add or Remove Programs” 
and then select “Add/Remove Windows Components” on the left hand side. The check box 
for “Internet Information Services (IIS)” should be checked. If not check it and continue with 
the installation of IIS.  This is a step-by-step view of the process. 
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Start > Control Panel > Add or Remove Programs 

 

Figure 11 : Windows Control Panel Menu 
 
Click on “Add or Remove Programs”. 
 
 
 

 
Figure 12: Add or Remove Programs 

After the screen has populated, select “Add/remove Windows Components” from the left-
hand column. 
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Figure 13: Windows Components 

 

The Windows Components Screen will open.  The check box for “Internet Information 
Services (IIS)” should be checked.  If not, check it, and continue with the installation of IIS. 

 

Checking for .NET Framework.  

Step 2: Check the Microsoft .NET framework is installed and up to date. 

 

This can be checked by looking for “Microsoft .NET Framework 1.1” in the list of installed 
programs, accessible through “Control Panel” and “Add or Remove Programs”.  It is 
important that version 1.1 is installed.  

This is a step-by-step view of the process 

Start > Control Panel > Add or Remove Programs. 
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Figure 14: Add or Remove Programs 
 

From the Control Panel, select “Add or Remove Programs”. 

 

 
Figure 15: Checking if .NET is installed 

 

If it is not installed it can be installed from the MCM installation CD. To do this run the 
program “dotnetfx.exe” located in the “Redist” directory on the MCM installation CD. 
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Figure 16: Installing .NET from the MCM installation disk 
 

After installing, or if already installed, “Windows Update” should be used to ensure the latest 
updates have been applied. 

 
Check asp.net extensions are registered with IIS 

Step 3 

When the .NET framework is installed asp.net extensions are registered with IIS. If however 
IIS was not installed when the .net framework is installed or IIS is uninstalled and 
reinstalled, asp.net extension will not be recognised. To check whether asp.net extensions 
are registered, go to “Control Panel”, select “Administrator Tools” and “Internet Information 
Services”. Expand the local computer entry, right click on “Web Sites” and select properties. 
On the “Home Directory” tab select “Configuration” in the “Application Settings” part. If 
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asp.net extension are recognised there should be an entry in the list for “.aspx”, if not it will 
be necessary to register them. The easiest way to do this is to uninstall the .NET framework 
and reinstall it. To do this go back to step 2 find the .NET framework in the list of installed 
programs and select “Change/Remove” and remove it. Then follow the instructions in Step 
2 to install the .NET framework from the CD. Note – The .NET framework must be 
uninstalled before reinstalling it. Installing it without first doing an uninstall will have no effect. 
It is possible to register asp.net extensions without reinstalling the .NET framework. An 
article on how to do this can be found on the Microsoft web site 
(http://support.microsoft.com/kb/841558). 

This is a visual step-by-step view of the process. 

From Windows© Start menu, select Control Panel, then Administrative Services. 

 

Figure 17: Windows Administrative Tools menu 

From the Administrative Tools menu, select Internet Information Services (IIS). 

 

http://support.microsoft.com/kb/841558
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Figure 18: Internet Information Services (IIS) Menu 

From the Internet Information Services (IIS) menu, expand the local computer entry. 

 

 

Figure 19: Local Computer entry expanded 

When the Local Computer entry is expanded, right click on Web Sites. 
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Figure 20:Local Computer Properties 

From the drop down menu, select Properties. 

 

 

 

Figure 21: Home Directory 

Select the Home Directory Tab. 
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Figure 22: Configuration 

From the Home Directory tab, select Configuration. 
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Figure 23: Mappings 

If “aspx.net” extensions are recognised there should be an entry in the list for “.aspx”, if not 
It will be necessary to register them.  The easiest way to do this is to uninstall the .NET 
framework and reinstall it.  To do this go back to step 2 find the .NET framework in the list of 
installed programs and select “Change/Remove” and remove it. Then follow the instructions 
in Step 2 to install the .NET framework from the CD. Note – The .NET framework must be 
uninstalled before reinstalling it. Installing it without first doing an uninstall will have no effect. 
It is possible to register asp.net extensions without reinstalling the .NET framework. An 
article on how to do this can be found on the Microsoft web site 
(http://support.microsoft.com/kb/841558). 

Step 4 (Windows server 2003) – Check ASP.NET service extensions are allowed 

If Windows server 2003 is the operating system on web server PC, asp.net service 
extension must be allowed. To check they are allowed open the IIS manager by selecting 
“Control Panel”, “Administrative Tools” then “Internet Information Services”. Expand the 
local computer entry and select “Web Service Extensions”. Check the entry for ASP.NET is 
set to allowed. 

http://support.microsoft.com/kb/841558
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2.2.6 Install MCM Web Server Application 
 

 
Figure 24: MCM Installation Screen 
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Figure 25: Install MCM Web Server Application 

 
If you have read the previous section and are ready to install The Web Server Application, 
then click on the Install MCM Web Server Application button on the main menu. 

 
 
 

 
Figure 26: MCM Web Server Setup Wizard 

The installer will guide you through the steps required to install MCM Web Server on your 
computer.  Click “Next” to continue. 
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Figure 27: Installation Folder Selection 
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Figure 28: Confirming MCM Web Server Installation 

 
If you have completed the previous screens, the installer will now install MCM Web Server 
on your computer.  Click “Next” to start installation. 

 

When the installation has finished you will receive an installation complete message.  Click 
“Close” and you will be returned to the main installation menu. 
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2.2.7 Install MCM Web Pages 
 

 
Figure 29: Selecting Install MCM Web Pages 

 

 
Figure 30: MCM Web Pages Setup Wizard 

 
The MCM Web Pages Setup Wizard will guide you through the required steps to install 
MCM Web Pages on your computer.  Click “Next” to commence the installation. 
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Figure 31: Select Installation Address 

 
The installer will install MCM Web Pages to the virtual directory, Procion.  If you wish to 
install to a different directory overwrite Procion with the new name.  The port can also be 
changed.  Click “Next” to continue. 

 

 
Figure 32: Confirm Installation 

 
The installer is ready to install MCM Web Pages on your computer.  Click “Next” to start the 
installation. 
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Figure 33: Installation Complete 

 

This page confirms that MCM Web Pages has been successfully installed. It is highly 
recommended that you now use Windows Update to check for any critical updates to the 
.NET Framework.  Click “Close” to exit.  You will now be returned to the main installation 
menu. 

2.2.8 Install MCM Timed List Server 
 

 
Figure 34: MCM Timed List (Server) Set-up Wizard 

The installer will guide you through the steps required to install MCM Timed List (Server) on 
your computer.  Click “Next” to continue. 
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Figure 35: Selecting an Installation Folder 

 
The installer will install MCM Timed List (Server) to the default folder.  To install in this folder, 
click “Next”.  To install to a different folder, type in the path, or search for the folder in 
“Browse”.  Select who will be using this computer; “Everyone” or “Just me”.  Select “Next” to 
install. 

 

 
Figure 36: MCM Timed List (Server) Installation Confirm 

 

The installer is ready to install MCM Timed List (Server) on your computer.  If you wish to 
review or change the settings click “Back”.  “Cancel” will abort the installation.  Click “Next” 
to start the installation. 
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Figure 37: MCM Timed List (Server) Installation Complete 

The MCM Timed List (Server has been successfully installed.  Click “Close” to exit the 
installation program and return to the main installation menu. 

 
 

 
Figure 38: Main Installation Menu 
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2.2.9 Install MCM Timed List Client 

 
Figure 39: Install MCM Timed List Client 

To install MCM Timed List Client go to the main installation menu and click on “Install MCM 
Timed List Client”. 

 

 
Figure 40: Timed List Client Setup Wizard 

The installer will guide you through the steps required to install MCM Timed List (Client) on 
your computer.  If you wish to abort the installation or install later click “Cancel”.  Click “Next” 
to continue. 
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Figure 41: Select an Installation Folder 

The installer will install MCM Timed List (Client) to the default folder.  To install in this folder 
click “Next”.  If you wish to install to a different folder, enter the path or click “Browse”. 

Disk Cost advises on memory usage. 

Select who will be using the computer, everyone or yourself. 

If you wish to abort the installation click “Cancel”. 

Click “<Back” to review previous screens. 

Click “Next >” to continue with the installation. 
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Figure 42: Confirm Installation 

The installer now has all the information it requires to install MCM Timed List (Client) on 
your computer.  Click “Next >” to start the installation.  If you wish to abort the installation 
click “Cancel”.  If you wish to review previous screens click “< Back”. 

 

 

Figure 43: Installation Complete 

MCM Timed List (Client) has been successfully installed.  Click “Close” to exit. 

MCM Timed List (Client) uses the .NET Framework, always use Windows Update to check 
for any critical updates to the .NET Framework. 
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2.3 The Application Wizard 
We recommend using the wizard to start-up the applications. 

 

Figure 44: MCM Wizard 

The wizard is divided into three sections: - 

• MCM Demo 

• MCM Live 

• Shortcut Wizard 

2.3.1 MCM Demo 
The MCM demo is a good place to familiarise yourself with the MCM program.  It provides 
an easy and safe introduction to using MCM. 
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Figure 45: Start MCM Demo Wizard 
 

Click on “Start MCM Demo”.  The wizard will open the Licence Manager Database, and 
General Remote Driver in the correct sequence. Finally the MCM Control Station will open 
a demo environment. 

 

 
Figure 46: Demo Environment 
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The demo will normally open in full screen mode (default).  Pressing F12 or ESC will reveal 
the normal editing options at the top of the screen. 

 
 

 

Figure 47: Tab Menus 

Clicking on the Tabs at the top-left reveals the following options and set-up screens: - 

 
 
 
 

Tabs Options 
File Log In 

Log Out 
Open Environment 
Recent Files 
Exit 

View Full Screen  F12 
Event Log    F1 

Libraries Register 
Unregister 
Information 
Router Library 
Master Control Library 
VTR Library 
GPI Library 

Tools Options (see figure below for details) 
Help Help 

Table 1: MCM Control Station Tabs 
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Options

Start Up

Network

Administrator

General Report missing files to Event Log
Cache button images
Credit Gauge always hidden
Credit Gauge always visible
Unattended operation
Search paths

Run Full Screen at Start-up
Start-up Environment Automatically re-open 

last used environment

Browse for Start-up
Environment

Licence Manager Host

Port

System Driver Host

Port

Client Host Name

IP Address

Client Name

Users Add New User

Remove User

Selected User  
Figure 48: Tools > Options Menu Tree 

 

2.3.2 MCM Live 
If you own MCM licences or you would like to try MCM on a real system, use the MCM Live 
buttons to configure and start the servers and/ or client applications.  You can use the 
wizards to guide you through the main server and client settings. 
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Figure 49: MCM Live Wizards 

2.3.2.1 The Server Wizard 

Clicking on the server wizard will take you through a four-step process. 

Step 1 – Server Ports 

 

Figure 50: MCM Server Wizard Step 1 - The Server Ports 

The servers provide services to client applications.  These services include licensing, 
routing, database interrogation, etc.  Servers listen for connecting clients on a specified port 
number.  Sometimes the port numbers need to be changed to prevent conflicts with other 
applications, or a firewall may be blocking certain ports. 

 

If you are having difficulties connecting to MCM servers, you may need to change the port 
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numbers.  To find out which port numbers to use, consult your network administrator.  If in 
doubt leave the port numbers unchanged. 

 

Click “Next” to continue to step 2. 

Step 2 – Router Database 

 

Figure 51: MCM Server Wizard Step 2 - Router Database 
 

The Router Database Driver manages Aurora, Nebula, and Freeway databases, which 
store information about routers such as source names, destination names, and so on. 

 

Click “Browse” to browse for the database for your router system or select “Use Demo 
Database” if you are running a demo version of MCM or you would like to browse for the 
database later. 

 

Click “Next” to continue to step 3. 
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Step 3  - Serial Port Settings 

 
Figure 52: MCM Server Wizard Step 3 – Serial Port Settings 

The General Remote Driver allows clients to control routers.  Select the PC serial port that 
is connected to the router system, or select “Use Demo Driver” if you want to try out MCM 
using a simulated router system. 

Click “Next” to continue to step 4. 

Step 4 – Licence Codes 

 

Figure 53: MCM Server Wizard Step 4 - Licence Codes 

The Licence Manager manages licence codes, which are used to licence application 
functionality. 
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You will need to enter licence codes into the Licence Manager to enable MCM functionality.  
If you own a copy of MCM, you will find a set of fully functional licence codes inside the 
MCM CD insert.  Alternatively, you can try out MCM using the trial codes inside the MCM 
insert.  This completes the set-up information required for the servers.  Start the Licence 
Manager if you intend to start-up the servers.  Click “Finish” to complete the set-up. 

 

Master Control Servers 

 

 

Figure 54: Starting The Master Control Servers 

To run the master control servers, click on “Start Master Control Servers” button. 

 

 
Figure 55: MCM Master Control Driver Screen 

The MCM master Control Driver Screen allows user setup of mixer logging, mixer/client 
logging, simulator, and port functions.  The “Settings Tab at the top left of the screen allows 
more configuration and user setups, the menu structure is shown below. 
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General

Network

Mixer Config

Clients

Automatically minimise on startup
Minimise to taskbar notification area
Log message errors
Operate in legacy mode

Master Control Driver
Licence manager

Port
Host
Port

Number of Mixers

Host
Port
Com Port
Interface TCP/IP

RS232

Number of Clients

Name
Group ID

Client ID  

Figure 56: MCM Master Control Server Settings Menu 
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2.3.2.2 Routing Servers 

 

 

Figure 57: Router Database Driver 

The “Settings Tab at the top left of the screen allows more configuration and user setups, 
the menu structure is shown below. 

 

General

Network

Automatically open database on startup
Auto minimise on startup
Minimise to taskbar notification area

Router database Driver
Licence manager

Port
Host

Port

Copy Editor Database Editor database
Driver database

Settings

 

Figure 58: Settings Menu 
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2.3.2.3 The Client Wizard 
 

 

Figure 59: Client Wizard 

To open the Client Wizard, go to the MCM Wizard and click on “Client Wizard”. 

 

 
Figure 60: Client Wizard 

The servers provide services to client applications. These services include licensing, 
routing, database interrogation, etc. If a server will be running on another PC on the 
network, enter the host name or IP address of the PC in the corresponding box.  Enter 
“127.0.0.1” if the server is running on the same PC. Click “Finish” to complete set-up. 
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Start Control Station 

 

To start the Control Station go to the MCM Wizard and click on “Start Control Station”.  The 
Control Station controls and set-up screens are discussed in the MCM Demo section 
previously. 

 

Start Designer 

To start MCM Designer go to the MCM Wizard and click “Start Designer”. 

2.3.3 Shortcut Wizard 

 

Figure 61: Desktop Shortcuts 

To start MCM without displaying the MCM Wizard, shortcuts can be added to the desktop 
or to the Windows Start-up folder.  To do this, use the Shortcut Wizard. 

 
 

 

 

 

2.4 Starting The Web Server 
Before starting the Web Server Application the MCM Database and General Remote Driver 
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should have been started.  To start the web server run the “MCM Web Server” either from 
the shortcut on the desktop or the start menu, then click the start server button on the 
application.  The web server should connect to the MCM drivers and retrieve information 
about the system from them.  At this point the application can be minimised where it will 
continue to run providing an interface between the web application and the MCM drivers. 

Loading the login page 

Once the web server application has been started the MCM canvases can be accessed 
through a web browser. 

Before MCM canvases can be displayed on the browser the client must log in using a MCM 
user name and password. The initial page that must be accessed through the browser is 
therefore the login page. To access this on a web browser, on the local machine the URL is 
http://localhost/procion/login.aspx. On another PC localhost should be replaced with the 
name or IP of the web server PC. 

Here is a visual step-by-step view of the process. 

 

Figure 62: MCM Web Server Shortcut 

MCM Web Server may be started either from the MCM Web Server desktop shortcut or 
from Windows “Start” menu. 

http://localhost/procion/login.aspx
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Figure 63: MCM Web Interface Server 

 

The “Options” Tab sets up the network locations of The Licence Manager, The Router 
database Drive, and the General Remote Driver. 

 

 

Click here to 
start the 
server 

Click on the 
Options Tab 
for settings 
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Figure 64: MCM Web Server Options 
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2.4.1.1.1 Web Pages 

 

 

Figure 65: Web Browser Login 
 

 

Figure 66: Select Directory 

 

URL for a Local PC 
 
On another PC localhost should be 
replaced with the name or IP of the web 
server PC 

User Name, 
Password, and 

Login 

Select Canvases 
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Figure 67: Select Directory 

 

 

Figure 68: Select Canvas Files 

 

 

Figure 69: Canvas Example 

Note for users of MS Internet Explorer ©. 

The MCM Web Server Application needs to continuously update, depending on your 
settings this can cause a clicking sound.  The way to stop it is to switch off the sound for 
"Start Navigation" for "Windows Explorer ". 

  

To do this 

  

Open "Sounds and Audio Devices" from Control panel. 

For this example, 
Select Demo 

Select a Canvas 
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Select the "Sounds" tab. 

Scroll down the list in the "Program events" window to "Windows Explorer" and "Start 
Navigation". 

Set the sounds to "None". 

Here is a visual step-by-step view: - 

From the “Start” menu select “Control Panel” 

 

Figure 70: Control Panel 

 

From the “Control Panel”, select “Sounds and Audio Devices” 
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Figure 71: Sounds and Audio Devices Properties 

 

From the “Sounds and Audio Devices Properties”, select the “Sounds” tab. 

 

 

Figure 72: Sounds and Audio Devices Properties 



MCM User Guide 

 
 70                                                                                                          Issue 1 

From the Sounds and Audio Devices Properties; 

Scroll through Program Devices to Internet Explorer, then to “Start Navigation”.  From the 
Sounds menu select “None”.  Click OK to confirm the changes. 

 

2.5 Workstation Configuration 
Single workstation 
If the user has a licence for only one user, it is likely that all components will be installed on 
the same PC. All the default IP addresses in the various components are configured for 
such a set-up, and the user will notice that the address ‘127.0.0.1’ is used throughout, 
which is the standard ‘loop-back’ address used for communication between networked 
applications on the same physical platform. 

Multi-Client Network 

If the user has a Multi-Client licence, the Licence Manager, System Driver, Router 
Database Driver and General Remote Driver will be installed on the ‘Server’ PC.  The 
Control Station will be installed onto the ‘Client’ PC’s.  In Multi-Client use the Licence 
Manager and Control Station will require the relevant Host name to be modified.  Once this 
is completed, opening the Environment file on the Control Station of the Client PC links this 
PC to the Server PC, where the relevant file is opened. 

The Designer can be installed on the client or server PC, usually the installation is on the 
server PC. 

General Workstation Notes: 
1. Even if a Multi-Client licence has been supplied it is usual to check the installation 

with the Control Station located on the Server PC. Once this has been achieved 
the changes to the Licence Manager and Control Station can be carried out to suit 
the Clients.  

2. The General Remote Driver Demo can be used to ‘test’ an environment before 
‘going live’.  
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2.6 Configuring the Licence Manager 
When first launched the Licence Manager will appear as follows: 

 

2.6.1 Licence requirements 
A minimum of 2 licences are required to run a MCM router control system, one for the 
General Remote Driver, and one for the Control Station. A ‘trial’ licence may be used, which 
will only allow the applications to run for a limited period of 30 days, or a full licence can be 
supplied by Pro-Bel. 

 

The trial licences available are as follows: 

• PR2-01T1-001 For General Remote connection to Aurora 

• PR2-02T1-001 For General Remote connection to Nebula (Sirius/Freeway) 

• PR2-11T1-002 For 2 basic router control clients 

• PR2-12T1-002 Additional for 2 advanced router control clients 

• PR2-21T1-002 Additional for 2 Monitoring clients 

• PR2-20T1-001 Additional for 1 VTR control client 

The last digits in each licence indicate the number of servers or clients and may be 
changed as required when using trial licences. 

2.6.2 Installation of the MCM licence codes 
Licences will operate in a fully functional trial mode for 30 days from the date that they are 
installed on a specific PC.  The licence will cease to function after 30 days and a licence key 
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will be required. 

The following TRIAL licence codes need to be entered into the Licence Manager as 
detailed below, however it is not necessary to request a licence key, and licence keys 
should ONLY be requested for full licence codes. 

For the Aurora Interface 
PR2-01T1-001 - This licence code can be used to operate one Aurora Interface Network 
server. 

PR2-11T1-002 - This licence code can be used to operate two Basic Router Control clients. 

For the Nebula/Freeway Interface 
PR2-02T1-001 - This licence code can be used to operate one Nebula/Freeway Interface 
Network Server. 

PR2-11T1-002 - This licence code can be used to operate two Basic Router Control clients. 

You may wish to use the additional features; 

PR2-12T1-002 - This licence code can be used to operate two Advanced Router Control 
clients. 

PR2-20T1-001 - This licence code can be used to operate one VCR Interface. 

In each case, the last three digits specify the number of servers or clients, and can be 
changed when running as evaluation licences. 

Once installed, components of MCM should be run in the following order: 

 

1. Licence Manager 

2. P2RouterDBDriver 

3. P2GenRemDriver 

4. P2SystemDriver 

5. P2Designer or P2Control. 
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2.6.3 Installing the Trial Licence Code 
Open the Licence Manager.  The following window will be displayed: 

 

 

A final Licence Manager screen may appear like this, but without the Configuration 
Directory entry, which is described in the next section: 
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Pressing the ‘Enter Licence’ button in the Licence manager will open the following window 

 

 

When entering the first licence code, the ‘Company Name’ text box will be enabled.  Enter 
the company name that you wish MCM to be registered to use the licences. Subsequent 
licences (Trial or Full) will use the same name.  

Note that leading or trailing spaces cannot appear around the company name, licence 
code, or licence key.  
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Enter a licence code and press the ‘Generate Installation ID’ button.   
For the Trial Licences this Installation ID is not required by Pro-Bel. 
Selecting OK shows the Trial Code installed in the Licence Manager. 

This procedure is repeated for all the Trial codes required. 
Trial Licence codes will operate in a fully functional mode for 30 days from the date that 
they are installed on a specific PC. 

The Trial licence codes will cease to function after 30 days. 

If the MCM Control Station is using a trial licence, and the 30 days trial period expires for 
that licence, the MCM Control Station will inform the user and then close the environment. 
The environment can only be restarted by entering a FULL Licence into the Licence 
Manager. 

A full licence must be purchased from Pro-Bel to continue to use a licence code. 

Please contact your local Pro-Bel Sales representative or contact sales@pro-bel.com who 
can generate the necessary full licence codes for the options you require.  

For each full licence code the user must generate an ‘Installation ID’, this and other required 
information needs to be forwarded to support@pro-bel.com who will generate the 
necessary licence keys. These keys will then be entered into the Licence Manager so that 
the licences do not time-out. 

2.6.4 Installing the Full Licence Code 
The purchased MCM Full Licence Codes are installed into the Licence Manager. The 
generated Installation ID information is required by Pro-Bel so that a corresponding Licence 

mailto:sales@pro-bel.com
mailto:support@pro-bel.com


MCM User Guide 

 
 76                                                                                                          Issue 1 

Key can be generated.  The key is entered using the Enter Key button.  

Once the Licence Key is entered the software will not time-out. 

2.6.5 Obtaining the Installation ID from the PC 
Open the Licence Manager and press the ‘Enter Licence’ button, the following window will 
be shown. 
When entering the first licence code, the ‘Company Name’ text box will be enabled.  Enter 
the company name that you wish MCM to be registered to use the licences. Subsequent 
licences (Trial or Full) will use the same name.  

Note that leading or trailing spaces cannot appear around the company name, licence 
code, or licence key.  

Enter a licence code and press the ‘Generate Installation ID’ button. 

 

 

The Licence Code entered in the window should be a Full Licence signified by an ‘F’ 
contained within it e.g. PR2-01F1-001 

A number will appear in the Installation ID text box.  The Licence Code and the associated 
Installation ID must be provided along with the exact company name as entered (including 
capitalization and spaces) in order to receive a valid licence key.  

Email this information as detailed in the Forwarding Licensing Information section of this 
document 
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2.6.6 MCM Licence Information 
• On start-up the MCM software checks for a Full Licence installed in the 

Licence Manager. If there is not a Full Licence present, it will use the Trial 
Licence.  

• The Trial Licence and Full Licences can be installed together but the Trial 
Licences will automatically be deleted after the 30 days trial period. 

• When a Full licence is installed, the MCM software will run for 30 days 
allowing time for the Licence key to be entered. If at the end of this period a 
Licence Key is not present the MCM Control Station will inform the user and 
close the environment. 
When a Full licence code expires, environments can only be restarted by 
entering a Full licence code AND licence key into the Licence Manager. 

• It is not necessary to enter trial codes if you have purchased the full licence 
codes. 

The Licence Manager screen below shows that the customer has entered the purchased  
‘F’ codes but has not entered a Licence Key for any. 

 

A Licence Key must be entered to stop the software from timing out 
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2.6.7 Receiving the MCM Non-Timeout Licence Keys  
Once the permanent licence code is purchased from Pro-Bel and the Installation ID’s have 
been generated, the required information should be emailed to support@pro-bel.com.   

 An E-mail will be returned to the user that will contain the required Licence Keys. 

Contact information is provided below and can also be obtained in the Licence Manager by 
selecting Help - About from the menu.   

 

 

 

 

 

 

 

 

 

mailto:support@pro-bel.com
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2.6.7.1 Entering the Licence Key 

 

The Licence Key is entered into the Licence Manager by selecting the relevant code in the 
list and using the Enter Key Button, once this has been completed the MCM functionality for 
the respective Licence Code will not timeout. 

 

The Licence Manager screen below shows that the customer has successfully entered the 
required Licence Keys allowing the software to continue to function. 

 

 

 

2.6.8 Forwarding the Licensing Information 
Information detailed below must be forwarded to the email address support@pro-bel.com .  
All Licence Codes with the associated Installation ID must be included.  Licence codes 
cannot be processed without a Pro-Bel sales order acknowledgement number.  An email 
will be returned to the provided email address, which will contain the licence keys required. 

mailto:support@pro-bel.com
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Sales order ACK: 
Company name: 
Contact: 
Phone: 
Email address: 
 
Licence Code: 
Installation ID: 
 
Licence Code: 
Installation ID: 
 
Licence Code: 
Installation ID: 

2.6.9 Selecting the configuration directory 
The Configuration Directory is a directory that contains configuration files.  Server and 
Client PCs require read/write access to this directory. Any folder may be used for this 
purpose but a better approach is for the user to add a folder named ‘P2Config’ into the 
Windows directory, e.g. ‘C:\Windows\P2Config’ or ‘C:\WINNT\P2Config’. 

2.6.10 Licence Manager Configuration Directory  
Single Workstation 

For a single Workstation the Configuration should be set as \\P2Config\ as shown below 
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Multi-Client Networks 

 For a Multi-Client network environment the Configuration should be set as  
                                      \\yourPCname\P2Config\ 

as shown below:- 

 

 

 

2.6.11 Enabling Read/Write Access for Multi-Client Networks 
Select the folder named ‘P2Config’ (or your specifically selected folder). Select the 
Properties tab and ensure that the following elements are set so that the folder can be 
shared over the network with read/write permissions. 
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P2Config General Tab P2Config Sharing Tab 
Select Share this folder radial button 

  

 

Permissions Window 
Ensure Full Control Selected 

P2Config Security Tab 
Ensure the Read Write are set to Allow 
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IMPORTANT NOTE: 
In many network environments it is not possible to allow Full Control to EVERYONE. Therefore your IT 
department must be involved in setting the various permissions between the Server and Client PCs. 

The application is now ready to accept connections from MCM Control Station Clients. 

2.7 Configuring the Router Database Driver 
On launching the MCM Router Database Driver for the first time, the following will appear: 

 

The user must open an Aurora or Nebula database in order that MCM Designers and MCM 
Control Stations may connect to it, if they are configured to do so. These clients may also 
use their own ‘local’ database, although this will not guarantee synchronized data sharing. 

If the database editor has been used on the same PC, the user may copy the most recently 
used on-line database, which will be called ‘CURR_SYS.AUR’ (or CURR_SYS.NE1 for a 
Nebula system), in the Program Files\Pro-Bel\Aurora Editor (or \Nebula Editor) directory, as 
a file called Procion2.aur, as follows: 
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The user can then open this database for use by clicking on ‘OPEN DATABASE’, as 
follows: 

 

Or alternatively, answer NO, and choose another database.  
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The Screen will now appear like this, and is available for clients to connect to: 
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The user must configure the default paths and database names in ‘Settings’, from the 
toolbar, as follows: 

 

NOTE: If the relevant Procion2 file is not contained in the folder a copy of the CURR-SYS 
file can be renamed as Procion2 (extension as above). 

2.8 Configuring MCM Designer 
When MCM Designer is first launched, the screen will appear as follows: 

 

Select the Editor Database button.  Via the 
window, select the file that is the current 

database file. Usually this is named  
CURR-SYS 

Select the Driver Database button.  Via 
the window select the file that is going to 
be used as the Procion Driver database.  

Usually, this is : - 
for Aurora - Procion2.AUR  

for Nebula - Procion2.NE1 or NE2 
for Freeway or Router Editor - 

Procion2.FR1 
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2.8.1 Database configuration 
The user must now decide which Aurora database to use. The choice is made by selecting 
‘Libraries\Router Library’ from the tool bar. The following will appear: 

 

In normal use the default driver database will be selected.   

If the Aurora Database Driver is already running, the user may select ‘Use Driver 
Database’. Do not edit the Port address unless there is a conflict. Note that the IP address 
127.0.0.1 is the ‘loop-back’ address for a driver on the same PC. 

If the Driver database is located on a different PC the host name will have to be entered 
(without //) or its IP address, instead of the default 127.0.0.1 

If the user chooses Local Database, they must specify a location and file name for such a 
database. 
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2.8.2 Configuring advanced options 
If the user has configured Licences to use the Advanced Router Control functions, they 
must enable this function in Designer in order to make the features available. This is done 
in Libraries\Router Library\General, as follows: 

 

 

Note that the Monitoring feature is not yet available. It is also noted that even if advanced 
features are designed into a panel, they will not function without the appropriate licence. 

Additionally, if the user requires the VTR Interface design tools activating, this must be 
enabled in Libraries\VTR Library, as follows: 
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MCM Designer is now ready to use, refer to Chapter 3 for further instruction. 
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2.9 Configuring the General Remote Driver 
In order to run the General Remote Driver, the Licence Manager and the Router Database 
Driver must also be running, usually on the same PC. In addition, a connection must exist 
to the General Remote port on the Aurora controller. If the first two of these conditions are 
not satisfied, the screen will appear as follows: 

 

 

 

The red screen colouring indicates that no Licence Manager has been located, and the log 
message ‘failed to connect to router database driver’, indicates that no Router Database 
driver was found. If both these conditions were satisfied, but no Aurora controller was 
found, the message ‘No response from controller’ would appear in the log. 

It can be noted that it is not essential for the Aurora Database driver to be running for the 
General Remote driver to function, although the user will find that the system will be slower 
to read router tallies. 

If the Licence Manager or Router Database Driver are not on the same PC, or if the PC 
COM port 1 is not being used to communicate with the Aurora controller, then the General 
Remote configuration will require changing. This configuration is configured in the Settings 
dialogue from the toolbar: 
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If the General Remote Driver is located on a different PC, the host name will have to be entered 
(without //) or its IP address, instead of the default 127.0.01 

The General Remote Driver settings shown here are the default for the Licence Manager and Database 
Driver on the same PC, and COM port 1 connected to Aurora or Nebula. 

Note that address 127.0.0.1 applies if the 
Licence Manager is running on the same PC.   

DO NOT EDIT THE PORT NUMBER UNLESS 
THERE IS A CONFLICT.  SEE YOUR IT 
MANAGER FOR ASSISTANCE 
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2.10 Configuring the MCM Control Station 
(Single Workstation) 
After the user has designed some control panels and saved them into an ‘environment’ file, 
they can be run on the MCM Control Station, either using a real system, or in test mode. 
The user should refer to Chapter 3 for instructions on designing control panels in MCM 
Designer. 

2.10.1 Licence Manager and System Driver connection 
With the Control Station and Licence Manager running on the same PC the default Host 
address should not be changed from 127.0.0.1.  If there is a conflict see your IT manager 
for assistance.  The Host address can be observed by selecting Tools, Options and the 
Network tab. 

 

2.10.2 Database and General Remote connections 
On start up the Driver Database and Gen-Rem Driver are selected by default.  These 
settings are shown by selecting Libraries\Router library’\Database Configuration tab or Gen 
Rem Configuration tab. 

Note that address 127.0.0.1 applies if the 
Licence Manager is running on the same 

PC.   

DO NOT EDIT THE PORT NUMBER 
UNLESS THERE IS A CONFLICT.  SEE 

YOUR IT MANAGER FOR ASSISTANCE 
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Note that address 127.0.0.1 applies as the Licence Manager is running on the same PC.   

DO NOT EDIT THE PORT NUMBER UNLESS THERE IS A CONFLICT.  SEE YOUR IT 
MANAGER FOR ASSISTANCE 

ROUTER CONTROLLER 
Note that address 127.0.0.1 applies as the Licence Manager is running on the same PC.   

DO NOT EDIT THE PORT NUMBER UNLESS THERE IS A CONFLICT.  SEE YOUR IT 
MANAGER FOR ASSISTANCE 

 

Note that ‘Host’ refers to the IP address of the PC running the drivers, and the address 
127.0.0.1 applies if the drivers are running on the same PC as the MCM Control Station. Do 
not edit the Port number unless there is a conflict.  The local database should be selected if 
this differs from the Driver Database i.e. if the user requires different source\destination 
names to be used. 
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2.10.3 Configuring the Client PC to run MCM Control Station 
Multi-client Networks 

After the successful installation of the MCM software onto the Server PC the Control Station 
software can be installed onto the PCs being used as Clients. When the Control Station is 
opened it links to the Licence Manager, System Driver, Router Database Driver, and 
General Remote Driver. These programs reside on the Server PC so the Host names 
within the Control Station must be changed to reflect this. 

NOTE: Before changing the Host Names it is important to check that: 

• The Licence Manager shows the correct Networking Configuration Directory 
e.g. \\yourPCname\P2Config\  --- See the Multi-Clients Networks information 
within the Licence Manager Section. 

• The P2Config folder is shared and has the correct read AND write 
permissions.  

• The directory containing Procion2 environment and canvas files is shared 
and has the correct read AND write permissions. 

2.10.4 Configuring the Control Station 
Run the Control Station software at the Client PC, and Login as Administrator.   
Select Tools, Options and the Network Tab. 
Replace the Host name for both the Licence Manager and System Driver with the name of 
the SERVER PC or its IP address.  

 

NOTE: The \\ MUST NOT BE USED when entering the Host name. 
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The same Host name should be applied to both the Database AND GenRem Configuration 
using the relevant tabs. 

To do this, select Libraries, Router Library. 

NOTE: The \\ MUST NOT BE USED when entering the Host name. 
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2.10.5 Naming Clients (Single Workstation) 
After the user has successfully logged-on as Administrator, the ‘Clients’ must be configured. 
Select ‘Libraries\Router Library’ from the toolbar, and configure all required Clients as 
follows: 

 

 

 

By default, the Client Name is the host name of the PC running each Control Station 
application. This can be found in the Control Station under Tools\Options\Administrator, 
where the client name can also be edited. It is this name that will be used to identify the 
owner of a protected route in a fully functioning system. 

The Client Device Number identifies a client and is used to display its unique name when 
required e.g. to display which client is protecting a destination. 

 

Edit the Client name by 
clicking on the field, 

names are case 
sensitive. All clients must 
have a unique number in 

the range 0 to 1023. 
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2.10.6 Configuring Clients – Multi-Client Networks 
After the user has successfully configured the MCM Control Station for Multi-clients, the 
new Client Name must be configured. 

Within MCM Control, Select ‘Libraries\Router Library’ from the toolbar and configure all the 
required Clients. 

The Client name 
uses the PCs host 
name, but can be 
edited here e.g. 
specific location 
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Each Client should be added to the list and given a unique Client Device Number. 

 

2.10.7 Opening an environment 
Finally, the user may open an environment in the configured directory by selecting 
‘File\Open Environment’ from the toolbar. If everything is configured correctly, no error 
messages will be given. 

2.10.8 Trial licence warnings 

 

When an environment is launched that contains features not supported by a full licence the 
screen shown above will appear. 
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2.11 Logging in to Add and Configure each 
User 
For the Control Statiion the default login name is ‘Administrator’ with no password, either 
from the server PC or client PC. 

 

 

 If required multiple users can be set up to use differing Procion2 environments that access 
the same database.  New users can only be configured by the Administrator. 

The Administrator password can be changed by selecting Tools, Options and Administrator 
tab.  The Change Password button is enabled by selecting Administrator 
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2.11.1 Adding a New User 
Select Add New User to display the screen below. 
Add User and Password for each user 
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2.11.2 User Access to the Environments 

 

Select the required user from the list as shown: 

 Note: When adding a User it is advisable to add a Unique ID by using the ID: up/down 
arrows. 

The ID identifies a user and is used to display their unique name when required. 

e.g when displaying users who have set Source Proctections 

2.11.3 Setting Environment Paths 
Click on the Configure Directories… and browse for the location of the environment file 
created in MCM Designer, these have the extension of .env and are usually located in  

C:\Program Files\Pro-Bel\MCM Vn.n 

Note: For a multi-Client network the Environment path should be set as 
\\yourSERVERCname\sharedfolder 
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Select OK to see Directory Path listed.  If the user requires access to other environments 
located within other directories select ADD and repeat the operation. 

 
Select OK to return to the Administrator tab. 
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Here the user has the ability to change the password using the Change Password button.  
They also have access to two tick boxes:- 

Master User, when ticked, allows the user to perform master operations from a panel e.g. 
source protects. 

Auto-Login, when ticked, ensures that the user is automatically logged in when MCM 
Control is started. 
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2.11.4 Locking Clients 
Both users and administrators have the ability to ‘lock Procion2 canvas’ from other users by 
placing a lock button onto the canvas. 

When logged on as Administrator, another way to achieve this without changing the canvas 
is to use the lock feature by selecting the Client tab. 

 

2.11.5 Unlocking Clients 

 

Only the administrator has the ability to unlock clients from the Control Station Options 
window.  If the logged on user is an administrator they are able to unlock an environment 
used by any other client, including other administrators. 

To lock a Clients 
environment, select 
them from the list 
and click on Lock 

To unlock a Clients 
environment, select 
them from the list 

and click on Unlock 
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2.12 Testing the configuration 
When all components have been configured, the user can test the installation by launching 
the applications in a specific order, and observing their interaction, as follows: 

• Launch the Licence Manager, the screen will appear as follows: 

•  

 

• Launch the Router Database Driver and open the required database (if not 
configured to open automatically), the screen will appear as follows: 

•  

 

• Launch the General Remote Driver, which will register with the Router 
Database Driver and the Licence Manager, whose client screen will appear 
as follows: 
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• If the General Remote Driver also successfully connects to the Aurora 
controller it’s screen will appear similar to this: 

•  
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• Launch MCM Designer, which should appear as follows, complete with all the 
function tabs: 

 

• To check that the correct Aurora Database is being accessed, the user must 
create a Source or Destination keypad (see Chapter 3) and view the 
properties of a single button, the database in use will be identified, as follows: 

•  
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• Finally, launch a MCM Control Station, each one will register with the Licence 
Manager, whose client page will appear as follows: 
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2.13 MCM Source Assignment Panel 
 

 
 

2.13.1 What is a Source Assign Panel? 
A Source Assign Panel (SAP) is used to program an Aurora router controller with the 
source allocations required by a Pro-Bel TX Master Control mixer. It is an essential piece of 
equipment in any Aurora router control system that includes a TX220, TX300, TX400 or 
TX500 series mixer. A Master Control mixer cannot preview, or put a source on air unless 
that source is assigned to one of its channels. A mixer may have any of its channels 
assigned to any video and audio source located on any router under control of the host 
Aurora system. On some mixers these may be assigned at the installation stage and never 
changed, however, on many systems operators may wish to change the channel 
allocations on a regular basis in order to suit operational requirements.  

The TX220, TX320, TX420 and TX520 mixers all have 20 channels on their Preset (PST) 
and Programme (PGM) busses, and 24 channels on the two Auxiliary (AUX1 and AUX2) 
busses. Channels 1 to 20 have the same video and audio assignments available across all 
4 busses, and channels 21 to 24 are available only to the Auxiliary busses. The TX310, 
TX410 and TX510 mixers have only 12 channels on the PST and PGM busses, and 16 on 
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the single Auxiliary buss. If any of these mixers are connected to an Aurora controller, all the 
sources must be assigned using a Source Assign Panel. 

Once assigned, the data is held in non-volatile (battery-backed memory) in the Aurora 
controller, and in a dual-controller system both controllers hold it. Consequently, this 
essential data is retained during system resets, controller changeover and the downloading 
of databases.  

Although this manual is written to cover the MCM product range, it would be useful to 
review previous SAP solutions: The SAP hardware panel and the Soft SAP. 

A hardware version of the Source Assign Panel has always been available, which is 
actually a 6277-2 type routing panel, with a special version of firmware installed. However, 
with the proliferation of PC hardware, it became desirable and convenient to provide a ‘soft’ 
version of the same panel. 

The Soft SAP uses the Babelfish as a protocol translator to interface the LAN on which the 
PC is connected, to the Multi-drop device port on an Aurora router controller. 

 

 

2.13.2 The Soft SAP 
The TX Soft Source Assign Panel is a piece of PC software designed to perform the same 
task as its existing hardware equivalent. Either panel is essential in any Pro-Bel Aurora 
router control system that includes a TX series Master Control mixer. The Soft SAP runs on 
a Windows 9X, NT, 2000 or XP operating system, and the user interface (GUI) is a direct 
representation of the hardware panel it replaces. A user can therefore easily adapt to the 
soft SAP if they have previously used the hardware panel. 

2.13.3 MCM Source Assignment Panel 
The MCM Source Assignment panel is MCM’s elegant solution to source assignment.  The 
panel is accessed through the MCM Control Station. 

Click on “File”, and from the pull-down, select Log In. 
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The “Log In” screen will appear.  If the system is password protected, enter your password, 
if not click “OK” to continue. 

 

 

 

From the File menu select “Open Environment”. 
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Open the SourceAssign directory. 

 

 

Select OneRow.env environment. 
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File View

Log In

Log Out

Open Environment

Recent Filter

Exit

Full Screen

Event Log

 

 

Libraries Tools

Register

Unregister

Router Library

Master Control Library

VTR Library

GPI Library

Information Library Information

General

Database 
Configuration

GenRem Config

Driver

Client Config

Edit Source Protect
Configure safe Source
Edit Salvos
Video Capture
Use Source Association Names
Auto Route Source protect Safe Sources
Source Protect Owner Take Only
Log Driver Functions

Database

Local Database
Driver Database

Use Local Simulator
Use Gen Rem Driver

Host
Port

Driver Config
TX502

General

Com Port
Timecode Source

Ctl
LTC
VITCUse Driver

GPI Driver Host
Post

Options

General

Start Up

Admin

Network

Report missing files 
to Event Log
Cache button images
Credit Gauge Always Hidden
Credit Gauge Always Visible
Unattended Operation

Search Path(s) Edit path
Add path

Run full screen at start up

Start up environment

Auto re-open last opened on start up

Use start up environment specified below

Browse for start up environment

Licence manager

Host
Port

System Driver

Host

Port

Client

Users

Lock
Unlock

Add new user
Remove user
Change pasword
Configure directories
Master user
Auto log in  

 

The full menu structure is shown above. 
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When the screen opens initially the channel buttons (ch1 to ch20) will show a row of 4 dots.  

 

 

 

 

Select the first mixer 
Button.  The button 
will change colour to 
reflect the “on” state. 
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In this example the sources are divided into three source sets, which may be selected using 
the three Source Set buttons at the bottom of the screen. To assign a source to one of the 
twenty channels: - 

• Select a source from one of the source sets 

• Click on the source button it should “light-up” in its on state. 

• Click on the Channel button to assign the selected source to that channel. 

• Repeat this procedure until the assignment is complete. 

 

Pressing the “Clear” button, followed by the channel button, will clear a channel.  The 
channel may then be assigned to another source or left clear.  It is not necessary to clear a 
channel before assigning a new source.  The process of assigning a channel will overwrite 
any previous allocation. 
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2.14 Security 
The system Administrator has the important role of creating Control Station users and 
passwords, as well as selecting the location of environment files they are allowed to 
access. Therefore the Administrator is responsible for system security, and must protect 
their authority accordingly. However, this does not provide total security against ‘browsing’ 
access to files for the normal Windows user, and therefore the Administrator should 
consider using the built-in Windows security to limit user access to valuable environment 
and canvas files. 

 

Mixer 
Buttons 

Channel 
Buttons 

Clear 
Button 

Source 
Buttons 

Source 
Set 

Buttons 
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3 Using the Designer 
MCM Designer is used to create the router control panel environment that will then be run 
on the MCM Control Station. This Chapter describes the functions and features of the 
Designer application both for the basic and advanced router control functions. The user will 
only be able to use the advanced features if the appropriate licence has been purchased. 

3.1 Definition of basic terms 
3.1.1 Environment 
This is the name given to the file that contains a collection of router control panels, arranged 
on one or more ‘canvases’. A MCM Control Station can run only one Environment file, 
which will be named by the user, in the form ‘user.env’, and stored by default in the location 
C:\Program Files\Pro-Bel-Procion2 Vn.nn on the host PC. The MCM Designer user must 
create an environment file with a unique client name before any panels can be designed. 

3.1.2 Client 
Every PC that runs a Control Station must have a unique client name, which by default is 
the same as the PCs host name, although this can be edited in the Control Station. Each 
Client must also have a unique number, in the range 0 to 1023, also configured in the 
Control Station by the administrator. The Licence Manager will only allow a pre-defined 
maximum number of clients to run at any time, determined by the licence number 
purchased  with the product. Client names are used by the Administrator to identify and 
lock, if required, any client environment, they are also used to identify the owners of 
protected routes. 

3.1.3 Administrators, Users and Master Users 
The administrator exists to configure the system and other users. Once created, a user can 
login on any Client (a PC running a Control Station), but their passwords and file 
accessibility is controlled by the administrator through the Control Station. The administrator 
can also define a user as a Master, which allows that user to access the Source Protect 
utility. Only the administrator can remotely lock and unlock client environments via the 
Control Station. 
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3.1.4 Canvas 
A ‘canvas’ is a single screen that will be displayed in the Control Station and will be a logical 
collection of router control functions. A  canvas can contain many control panels, tallies, 
images and graphics and must be saved independently of the environment in a user 
named ‘user.can’ file. An environment can contain several canvases, and a canvas can 
exist in more than one environment. Multiple canvases in the same environment are 
switched between using ‘canvas buttons’. 

3.1.5 Panel 
A surface, with a user specified colour, onto which keypads, buttons, tallies and graphics 
may be layered. A canvas may contain multiple panels, and panels may be pasted into 
more than one canvas. 

3.1.6 Source and Destination keypads 
A group of buttons with assigned captions or images, allocated to specific Source or 
Destination associations by the designer. Source and Destination keypads must be 
members of an ‘XY Group’ or ‘BPX Group’, which then determines which keypads are 
operationally linked. See Sections 3.1.9 and 3.1.10 for the difference between these 
groups. 

3.1.7 Source and Destination buttons 
As above but allocated to only one source or destination each. Must also be a member of a 
group. 

3.1.8 Canvas buttons 
This is the button that allows the operator to switch between different pages in the same 
environment. 

3.1.9 XY Group 
A collection of Source and Destination, keypads and buttons, which are operationally 
linked. This means that sources can be routed to destinations only if they are in the same 
group. Further, when a source button is clicked on, it is only ‘pre-selected’ to the currently 
active destination, and the route will not be made until a ‘take’ button is pressed. If the user 
wishes a route to be made immediately a source is selected, they must use a ‘BPX Group’.  

3.1.10 BPX Group 
A collection of Source keypads and buttons all operationally linked to a single Destination 
allocated to the group, or a group of destinations allocated to a destination keypad in the 
same group. The difference between a BPX Group and an XY Group is that no take button 



MCM User Guide 

 
 120                                                                                                          Issue 1 

is required in a BPX group. 

3.1.11 Text and Image Tallies 
A  tally is ‘feedback’ from the router under control, and therefore indicates it’s current status. 
Text tallies are associated with a destination, and will indicate, using a name from the 
database, which source is currently routed on a specified level. An image file may be 
allocated to specific sources, which will then indicate destination status using a graphic 
instead of a name. Tallies must be part of the group containing the associated destinations 
in order to function. 

3.1.12 Married tally 
Indicates if a specified route, or the currently active route, is married or not. See Section 
1.2.6 for a definition of married and unmarried routes. Married tallies must be part of the 
group containing the associated destinations in order to function. 

3.1.13 Protect Tallies and Buttons 
A protect tally indicates the protect status of a specified (or the currently selected) 
destination, that is, if the route is locked, and by whom. A protect button allows the user to 
lock and unlock specified routes; only routes locked by that user may be unlocked. Protect 
Tallies and Buttons must be part of the group containing the associated destinations in 
order to function. 

3.1.14 Take button 
A take button must be assigned to an XY Group, since routes will only be ‘pre-selected’ until 
the take button is pressed.  

3.1.15 Level buttons 
Level buttons may be assigned to one or more levels on a specified matrix. This then 
allows routes to be ‘broken away’ from their normal married associations, by de-activating 
levels prior to using the take button. They also allow the status of routes to be interrogated 
by viewing the destination tally response as different levels are activated. Level Buttons 
must be part of the group containing the associated destinations in order to function. 

3.1.16 Preselect tally 
A Preselect Tally display is assigned to a specific level for which it will then display the name 
of the source currently preselected to that level. This is used with XY panels, with a Take 
button, to show what will be routed to respective levels if the take button were to be 
pressed. May be used in combination with “Use Levels” buttons to allow preselections to be 
made by clicking directly on the Preselect Tally display. 
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3.1.17 Use levels 
This button is used in conjunction with Level Preselect displays in order to allow operators 
to quickly preselect sources to different levels before using the Take button. When the Use 
Levels button is active the operator uses the level buttons in the normal way, de-selecting 
the levels which will remain unaffected by a Take. When the Use Levels button is inactive, 
the user may preselect sources by clicking on the Preselect Tally displays after clicking on 
the desired source button, in this way an unmarried source preselection may be easily 
configured prior to a Take operation. 

3.1.18 Status 
This display may be added to a BPX or XY panel group in order to indicate any user mis-
operation, such as attempting to make routes within a locked environment, or trying to 
change a protected crosspoint 

3.1.19 Lock 
When added to a canvas this button allows the user to Lock the entire active environment, 
and preventing any routes to the changed. The button may be configured in Designer to 
require a password in order to de-activate it. If the System Driver application is running, any 
administrator may remotely lock and unlock a user environment. 

3.1.20 XP grid 

 

Click on crosspoint to 
change route, using 

level buttons to create 
break-aways 
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The Crosspoint Grid is a feature that allows the status of a pre-configured number of 
sources and destinations to be displayed for a single matrix. It also allows routes to be 
changed by simply clicking on the appropriate crosspoint, it must be noted that the 
crosspoint will be immediately taken on a mouse-click and therefore the XP Grid must be 
used with care. The matrix may be multi-level, in which case crosspoints are shown as 
‘cake slices’ of different colours, and level buttons are used to create level break-aways. 
The XP Grid and level buttons must be in a BPX or XY group in order to function, 

3.2 Definition of advanced terms 
3.2.1 Config Button 

 

By adding this button to a BPX or XY panel group, three features may be configured, as 
follows: 

• Edit Source Protects. See Section 3.2.6 

• Configure Safe Sources. 3.2.7 

• Edit Salvos. See Section 3.2.2 

3.2.2 Salvo 
A Salvo button is configured in Designer to use either a Database or Procion salvo. If a 
Database salvo is selected then the exact crosspoints stored in the Nebula or Aurora 
database file for that salvo will be fired. If a Procion salvo is selected, then that salvo must 
be configured through the Control Panel application using Build Salvo and Config buttons, 

Clicking on a Config Button in 
the Control Panel opens the 

menu shown here 
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as follows: 

Set up the crosspoint configuration required using source and destination keypads in the 
normal manner. Activate the Build Salvo button and select all destination buttons that are 
required in the salvo, then de-activate the Build Salvo button. Select the Config button, and 
Edit Salvos. 

 

If the holding store contains the exact required crosspoints, call up the salvo number from 
the drop-down menu and click on Copy All Crosspoints To Salvo, if not, copy the selected 
ones. Click OK. 

To fire the Salvo click on the appropriate salvo button followed by Take. A Take operation is 
not required if the control panel is part of a BPX group. 

3.2.3 Build Salvo 
Required in order to configure a salvo in a Control Station. See Section 3.2.2. 

3.2.4 Gang 
If this button is added to an XY panel group it allows the operator to preselect multiple 
routes which can then be taken in a single operation. This functions by first activating the 
Gang button, then selecting a Source followed by a Destination, the selection will be 
displayed in the Destination button display, followed by any other number of selections. The 
entire selection is routed with a Take operation. The Gang take may be ‘undone’ using a 
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Gang Undo button, which routes all Destinations back to their original sources. If Take is not 
pressed, and Gang is pressed to leave gang mode, all selected routes are entered into the 
holding store, see Section 3.2.2. 

3.2.5 Gang undo 
See previous Section. A Gang Undo button must belong to an XY panel group to function. 

3.2.6 Source protect 
Source protection allows specific sources to be routed only to certain destinations. If an 
attempt is made to route those sources to other destinations an error message will appear 
in the Status Display, see Section 3.1.18. This feature can be made to be specific to certain 
users only, and there are two ways of implementing it: 

• Source Protect button: If this button is included in an XY or BPX panel group 
it may be used directly to configure source protects. It functions by first 
activating the button then selecting a source followed by the required 
destination(s), when all routes have been selected, the Source Protect button 
is de-activated and the feature is immediately implemented. 

• Config Button: See Section 3.2.1. One of the operations accessed through 
this button is the Source Protect feature. When selected, a grid is displayed 
which allows the user to select source protects as follows: 

 

The routes Set indicate the only routes allowed for those specific sources. The exact source 
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and destination names are shown by hovering the mouse cursor over the grid. It is noted 
that these limitations only apply to the indicated user. It is useful to note that when the 
mouse cursor is moved across the grid the appropriate Client and User name will appear in 
the windows if any source protects have been configured for that source, this is particularly 
useful when not all routes are visible on the grid. 

3.2.7 Safe Source 
A safe source is one that will be routed to a destination to in the event that it is no longer 
permitted to be routed to its current source. This would happen when a Source Protect is 
applied to a system in which certain routes become invalid as a consequence. 

3.3 VTR Panels 

 

With the appropriate Licence, VTR Control panels can be configured as part of any canvas, 
see Section 3.4.6. These allow the user to control a Sony 9 pin VTR protocol enabled 
device over a PC COM port. The panel provides all the standard control types as follows: 

• Play, Wind, Stop, Standby, Eject 

• Jog, Shuttle, Varispeed, using mouse or keyboard cursor 

• Timecode display using a Ctl, LTC or VITC signal within the serial connection 

• Cue to timecode entered in display 
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3.4 Creating router control panels 
After MCM Designer has been successfully configured and tested according to the 
instructions in Chapter 2, the user can start to design a control panel environment. 

3.4.1 Creating and saving Environments and Canvases 

 

Launch MCM Designer. If this is for the first time, a blank canvas will appear and the user is 
free to add graphics, keypads, tallies etc. to the blank page. When appropriate, both the 
canvas and the environment must be saved. Note that both these functions are available 
through the ‘File’ menu on the toolbar, but the Save icon only saves the current canvas. 

If required, the user can now create new canvases in the same environment, using the 
‘New’ icon, or the File menu. ‘Canvas buttons’ will now be required on every canvas to allow 
the operator to switch between screens. 
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3.4.2 Creating keypads 

 

Select the ‘Routers’ tab in Designer, click on either the ‘Source Keypad’ or ‘Destination 
Keypad’ icon, and then click on the canvas. The resulting keypad can be manipulated as 
follows: 

• The number of buttons is changed by ‘clicking and dragging’ on a corner or 
side 

• The button size is changed by ‘clicking and dragging’ on the red lines 

Right mouse click on the required button and select ‘properties’. From the ‘Control/Status’ 
tab, the appropriate source or destination may be selected from the list, followed by ‘OK’ or 
‘OK Next’. 
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It is noted here that the user has the choice of using Source or Source Association names, 
as explained in Section 1.2.3. See Section 3.5.1 for instructions on selecting the Source 
Association name mode. 

If the ‘Visual’ tab is now selected, several more button options are available. These are as 
follows: 

 

• Show Image/Show Caption: allows text and/or a graphic to be allocated to the 
button from the ‘image’ and ‘caption’ tabs 

• 3D border: gives the button a dropped border 

• Use Colour States: Uses the colours defined in the ‘Colours’ tab for different 
states of the button, such as active, hover, pressed; the user may change 
these colours 

• Button Toggles: not currently used, although the button visually changes. 

• Use Database Names: used in conjunction with ‘Show Caption’, where the 
caption will be the same as the name from the database used for this button 

Common properties can be applied to all buttons on a keypad by right clicking on any 
button and selecting ‘keypad properties’, where all the above may be applied globally to the 
keypad. 

All the above properties may be applied to single Source or Destination buttons, which are 
selected from the ‘router buttons’ tab: 



MCM User Guide  

 
 HU-MCM  129 

 

3.4.3 Text and Image Tallies 
Just like keypads and buttons, text and image tallies may be ‘picked and placed’ onto the 
canvas. The properties of these objects are accessed by double clicking, or by right clicking 
and selecting ‘properties’. A  tally must have a destination and level assigned. 

 

Text tally properties, 
‘Use Active Dest 

Assoc’ means that the 
tally will reflect the 

status of the currently 
selected destination 
rather than a single 

destination assigned 
in the properties 
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3.4.4 Other Objects 
The remaining router control objects have specific features summarized here: 

• Canvas button: must be assigned to one other canvas in the same 
environment, does not need to be a member of a group 

• Married tally: must have an image assigned to the ‘married’ and ‘unmarried’ 
states 

• Level button: must be allocated to one or more levels 

• Protect button: can be part of an XY or BPX group, when in an XY group it 
must be used in conjunction with a Take button 

• Protect tally: must have images assigned to the three different states; can be 
allocated to the ‘active’ or any specific destination 

3.4.5 Assigning objects to groups 
All the following objects must be assigned to a BPX or XY group in order to function: 

• Source and Destination keypads 

• Text and Image tallies 

• Protect buttons and tallies 

• Level buttons 

• Married tallies 

• Take buttons 

They are assigned to a group by selecting them, either individually or globally, then right 
mouse clicking and selecting ‘add selection to group’. See Sections 3.1.9 and 3.1.10 for an 

Image tally properties. Images 
may be assigned to each tally 
individually, or using a ‘global’ 
assignment table, see Section  

3.5.1 
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explanation of how groups function. 

 

3.4.6 Adding VTR panels 
Providing an appropriate Licence has been configured and the feature enabled in Designer, 
the user may add VTR Panels, Online Buttons and VTR Groups to a canvas, as follows: 

 

An Online button is required for each VTR panel, and both must be in the same VTR Group 
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in order to function, therefore a single VTR button will activate all VTR Panels in the same 
group. When the panel appears in a Control Panel, it will not function until it has been 
assigned to a PC COM port with an RS422 connection to a device communicating with 
Sony 9 pin VTR protocol. This is configured in the Control Panel from Libraries\VTR Library. 

 

3.5 Tips and features 
3.5.1 Using Source or Association names 

 

This Window is available from ‘Libraries\Router Library’ on the toolbar, and determines what 
images are displayed for Image Tallies when in Global Image mode, see Section 3.4.3. It is 
also used to determine whether Source Association names or Source names are to be 
globally used when assigning names and captions to Source keypads, see Section 3.4.2. 

 

 

 

 

 

 

The PC port and 
Timecode source must 

be configured in the 
Control Panel 
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Using the ‘Assign….’ Buttons, the user can now allocate images, from a chosen directory, 
to all sources and associations, as follows: 

 

3.5.2 Grouping objects 
The mouse cursor can be used in Designer to ‘click and drag’ around a group of objects, 
which is usual to assigning global properties, such as group member ship or button colours. 
Note that the same can be achieved by holding the keyboard ‘Ctrl’ key and clicking on 
objects. 

When clicking-and-dragging on objects inside panels, the keyboard Shift key must be held 
in order to define a selection rather than a panel move. 

3.5.3 Transparency 
If the ‘Transparent’ property of an object is selected, the background of that object will be 
transparent to the object behind. The ‘background’ of an object is defined by whatever 
colour is present in the top left hand corner. 
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3.5.4 Options 

 

This window is available from the ‘Tools’ menu, and has the following options: 

• Show coordinates in status bar: the exact cursor XY position and object 
dimensions are shown at the bottom of the screen 

• Automatically re-select cursor: After an object has been placed on the 
canvas, this ensures that the mouse cursor becomes a selector once more, 
otherwise it will remain in object placing mode 

• Snap to grid position: ensures that objects align with the grid structure as 
defined by the ‘Grid Spacing’ dimensions; with the box un-ticked, objects may 
be freely placed 

• Only select objects entirely enclosed in selection region: Used when grouping 
objects, see Section 3.5.2, allowing the user to partially click-and-drag around 
objects in order to select them 

• Automatically re-open last environment on start up: Designer will always open 
the last used environment file when launched 
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3.5.5 True Type Fonts 
MCM supports True Type Fonts, as indicated by the ‘TT’ or ‘O’ symbol in the fonts menu for 
captions and text. These fonts give improved resolution and choice of size over normal 
fonts. 

 

3.5.6 Run Environment 
This available from the ‘Tools’ menu in Designer, and is simply another shortcut to the MCM 
Control Station. Therefore MCM Control Station must be installed and configured on the 
same PC in order for this to work. The user is still required to log in unless Auto-Login is 
selected within the MCM Control Station. 

3.5.7 Database error 

 

If the following error is indicated when the Designer opens an environment, it usually 
means that Designer is currently registered to a different Aurora database to that originally 
used to design the control panels. The user should check which database is currently 
selected from  ‘Libraries\Router Library’  on the toolbar. This may be due to the Aurora 
Database driver having been re-configured. 

3.5.8 Registering a library file in Designer 
The Designer application cannot be used until it has registered with a library file. Although 
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this is usually done automatically when the application is first launched, it may be 
necessary for the user to check or update the library registration. The Library file gives the 
application a range of features and resources, which will be periodically updated by Pro-
Bel. To register with the current library file, click on ‘Libraries’ on the toolbar, followed by 
‘Register Library’. Libraries reside in the C:\Winnt\System32 directory, as follows: 

 

Select the latest  ‘P2RouterLibxxx.’ file and click ‘Open’. The main screen will appear as 
follows with a complete range of function tabs: 
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4 MCM Timed List Server 
MCM (Morpheus Control and Monitoring) is the new name for Procion.  Legacy documents 
and existing file paths may still refer to Procion 2 or P2.  For the purposes of this document 
Procion and MCM are interchangeable.  The MCM Timed List Server is a fully featured 
scheduling application.  Its intuitive and user-friendly design integrates seamlessly with the 
MCM Suite.  It allows the user to set up routes using simple drop-down menus, then using 
the timed event list, switch on a once-off basis, a daily, weekly, or monthly recurring mode. A 
summary of its key features is: - 

• Seamless integration with MCM 

• Route switching 

• Transient Event Switching 

• Daily, Weekly, and Monthly Event Switching 

• Error Logging 

 

4.1 Starting the MCM Timed List Server 

Timed
List Server

Licence
Manager

Database
Driver

General
Remote
Driver

other client
applications

Timed
List (Client)

Timed
List (Client)

 

Starting the MCM Timed List Server establishes communications with the Licence 
Manager, Database Driver and General Remote Driver. It also registers itself to allow timed 
list client applications to connect to it. 
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The Start-Up Screen 

 

 
 
 

Once the Timed List is started and events are loaded, the display is scrolled using the four 
buttons on the bottom. The Page Up and Page Down buttons, scroll up and down the 
display. The Next Event button aligns the display such that the next event to be started is at 
the top of the display. A standard windows scroll bar is not used because the display range 
is likely to be infinite if recurring events are loaded without an end date. 

 

 

Page Up 
Scrolls the page up 

 

Page Down 
Scroll the page down 

 

Next Event 
Re-arranges the event list so that the Next Event to 
activate is shown at the top of the list. 

 

Top Of List 
Scrolls pages to the top of the list – useful when there 
is several pages of data. 
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Clicking on Schedule offers three options; Start Scheduler, Network Options, and 
Configuration. 

 

 

To start up the scheduler click on the 
Schedule tab and select Start 

Scheduler from the drop down menu 
 

 

To access the Network option, 
Select Network Options and proceed. 

 

To access the Configuration menu 
Select Configuration and Colour 

scheme and proceed 
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4.1.1 Network Options 
Clicking on the Schedule tab and selecting Network Options from the drop down menu will access the 
Network Options.  These options are used to connect to the Licence Manager, the Router Database 
Driver, and the General Remote Driver.  The port number in the client interface shows the TCP/IP port 
number that client applications will use to connect to the timed list server. 
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4.1.2 Configuration and Accessibility 
The configuration menu can be accessed by clicking on the Schedule tab, Configuration, and selecting 
Colour Scheme. Schedule > Configuration > Colour Scheme. 

 

4.1.2.1 Colour Scheme 

The colour option allows the screens to be customised perhaps to a corporate livery or personal 
preference. 

4.1.2.2 Accessibility 

Ensure that foreground and background colour combinations provide sufficient contrast when 
viewed by someone having colour deficits. 
The combination should use good, contrasting colours and/or the user should be able to select 
the colours to be used. 
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To change the Background colour to Green for example, click the background colour EDIT button.  This 
opens a colour palette that allows you to choose a new colour scheme. 

 

It is also possible to create a customised colour.  Open the colour palette and click Define Custom 
Colours this will expand the colour palette. 
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Colours can be defined by using one of the following colour construction methods: -  

• Colour Picker 

• HSL 

• RGB 

4.1.2.3 Colour Picker 

 

The colour picker is a user-friendly method that allows the user to simply point to a colour on the 
rainbow palette and click to select. 
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4.1.2.4 HSL 

Hue, Saturation, and Lightness (HSL) is a classic method of defining a colour.  It is based on how an 
artist would mix colours. Hue (H) is the colour or pigment and is measured in a circle from 0 to 360 
degrees (see table).  Saturation ranges from 0 to 100% and defines the grey in the colour.  0% 
indicates grey and 100% is the pure primary colour.  Lightness is intuitively what its name indicates; 
varying the lightness reduces the values of the primary colours while keeping them in the same ratio. 

 

Colour or Hue Degrees 

Red 0 ° 

Yellow 60 ° 

Green 120 

Cyan 180 ° 

Blue 240 ° 

Magenta 300 ° 
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4.1.2.5 Red, Green, and Blue (RGB) 

 

RGB is the preferred engineering colour space 
model. It constructs colours from the three primary 
colours; Red, Green, and Blue.  Each primary can 
be adjusted from 0 to 255.  Typical values are 
shown in the table. 

 

 

  

 

 

COLOUR RED (R) GREEN (G) BLUE (B) 

Red 255 0 0 

Green 0 255 0 

Blue 0 0 255 

Yellow 255 255 0 

Cyan 0 255 255 

Magenta 255 0 255 

  

4.1.2.6 Custom Colours 

Having mixed your colour you can save it to the Custom Colour area of the palette by clicking the Add 
to Custom Colours button.  Up to 16 colours can be chosen. 
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4.1.2.7 Default Colours 

Clicking the Default button beside each selection will reset that particular item to the default colour or 
property. 

4.1.2.8 Font Selection 

The Font and Font size can be varied depending on the pc installed font set.  This can also be restored 
to the default font of 10pt Arial. 

 

Click on the Font Selection Edit button to access the 
font selection menu 

Select Font from the menu 

Click OK to apply 

To undo and reset click Default. 
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4.2 The Scheduler 
 

 

Click on the Schedule tab at the top left of the 
screen.  From the drop down menu select 
Start Scheduler. Schedule > Start Schedule.  

When the Scheduler has connected, extra menu items will be available. 

 

 

 

 

 

Events Tab 
Has been 

added 
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Clicking on the Schedule tab will now add 
the following options. 

1. Clear: Clears future timed events.  
Does not clear past timed events 

2. Append: Adds a stored schedule to the 
current schedule. 

3. Save: Stores the current schedule to 
disk 

4. Export / Import: Exports or Imports 
CSV type files. 

 
 

The Configuration also has additional 
menu option “Server Options” added.  This 
allows configuration of: - 

1. Default safe Source: Source a 
destination will revert to at the end 
of an event, if it is not overridden to 
another source, or set to none. 

2. Played Window: Length of time 
events in the past remains 
viewable. 

3. Event Logging: Allows a text file to 
be specified that will contain a log of 
events processed. 

 

 

 

 

Extra Items 
added to 
Schedule 

Menu 

Server 
Option 
added 
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4.3 Events Menu 
 

 

To view the Events menu click on the Events tab. 

 

The Events Menu allows a Transient, Daily recurring, Weekly recurring, or Monthly recurring event 
to be added. 

Transient Event: is a one off event. 

Daily Recurring Event: is an event that occurs on a daily basis. 

Weekly Event: is an event that occurs on a weekly basis. 

Monthly Event: is a monthly recurring event. 

 

 

4.3.1 Adding a Transient Event 
Select Events > Add > Transient. The Add Transient input screen will appear. 
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Title: Enter the Title of the event.  This will appear in the schedule list column under Title. 

Start date: This is the starting date for the event.  The time can be directly entered or via the drop 
down calendar. 
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The calendar highlights today’s date in red and the start date in grey. 

Start Time:  This is the starting time for the event and is entered in 24-hour clock notation. 

Duration:  This is the duration of the event and can range from 00:00:01 to 23:59:59. 

End Time: This is the end time for the event and is entered in 24 Hour clock notation. 

Client Name: If an event is added from the server application, it is possible to specify the client 
name for the event.  Since client applications only show events relating to their list, the client name 
must match the name configured in the client application in order for it to appear on a client 
applications list.  When an event is entered from a client application the client name is automatically 
added and is not configurable for an event. 

 

Routing 

Click on the Routing tab to enter routing details. 

 

This screen allows you to enter the Destination, Source, Safe Source and Levels details.  
Selections are made from the drop-down menus, which are derived from the Aurora database. 
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Safe Source Options: 

Default: Default safe source configured for the server is set at the end of the duration. 

None: No safe source, the destination is not changed at the end of events duration. 

Matrix and Source:  Source to set at the end of the duration. 

Information. 

Click on the Information Tab. 

 

This screen allows you to enter customer details and other useful text.  It accepts normal cut and 
paste editing. 

 

4.3.2 Adding a Daily Event 
 

 

To add a Daily Event, click Events > Add > Daily.  This will open the Daily Events Screen. 
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This example is a daily Event.  It is titled “My Daily Event 002”.  The starting date for the event is 12 
July 2006 and no end day is selected, so this event will occur every day.  Its start time is 16:15:18 
with duration of 30 minutes finishing at 16:45:18.  The timing inputs are dynamically refreshed to 
reflect changes. For example setting the start time to say 13:00:00 and the duration to 00:30:00 will 
automatically show 13:30:00 in the End time.  Setting the Start Time to say, 15:00:00 and the End 
Time to 15:17:00 will automatically be shown as Duration 00:17:00.  If the End Time were now set 
to 16:00:00, the Duration would be increased to 1 hour but the Starting Time would remain 
unchanged.  The Start Time is a fixed reference and will not dynamically refresh with changes to 
the other inputs.  It can only be changed manually; this is a safety feature. 

 

Start Date: The start date for the event.  May be entered directly or via the drop down calendar. 

Start Time: The start time for the event.  May be entered directly or by the scroll controls. 

Recur every (days): Sets the interval between recurring events from 1 to 100 days. 

No End date:  No end date the event will recur indefinitely. 

End After: Sets the number of occurrences of the event. 

End By: Sets the last possible date for an event.  This is not always the last date of the occurrence 
see the graphic. 

Client Name: The client’s name (Server only). 
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In the graphic the Start Date is May 1 and the End By date is May 9, which is 9 days.  The Recur 
every (days) has been set to 3.  So the first event will be May 1, then 3 days later May 4, and the 
final event will be 3 days later on the May 7.  There will be no event on the End By date May 9 as it 
is not a multiple of 3 days. 

 

 

 

4.3.3 Adding a Weekly Event 

 

To add a Weekly Event click Events > Add > Weekly.  This will open the Weekly Events Screen. 
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This is a Weekly Event example.  The starting date is the 11th July 2006 and the No End Date and 
Monday has been selected, so this event will occur every Monday indefinitely.  The time is 14:59:47 
and the duration is 30 minutes with an end time of 15:29:47. 

Start Date:  The start date for the event.  May be entered directly or via the drop down calendar. 

Start Time: The starting time for the event in 24-hour format.  May be entered directly or by the 
scroll controls 

Duration: This is the duration of the event and can range from 00:00:01 to 23:59:59. 

End Time: This is the end time for the event and is entered in 24 Hour clock notation. The minimum 
setting is 00:00:01 to maximum 23:59:59. 

Recur every (weeks): Sets the interval between recurring events from 1 to 100 weeks.  An event 
can also be set to trigger on the same day of the week e.g. Tuesdays. 

No End Date: No end date the event will occur indefinitely. 

End After: Sets the number of occurrences of the event. 

End By: Sets the last possible date for an event.  This is not always the last date of the occurrence.  
For a further explanation refer to Transient Event End By explanation. 

Client Name: The client name (Server only). 



MCM User Guide 

 
 156                                                                                                          Issue 1 

 

 

4.3.4 Adding a Monthly Event 
 

 

To add a Monthly Event click Events > Add Monthly.  This will open the Monthly Events Screen. 
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The example is a monthly event.  The Starting date is the 1 July 2006.  The starting time is 17:01:07 
with duration of 30 minutes giving an end time of 17:31:07.  In this case the End After check box has 
been selected and has been set to occur 4 times on the 6th of each month.  So for this example the 
event will occur at the specified time on 7th July, 7th August, 7th September, and finally on 7th October. 

Start Date:  The start date for the event.  May be entered directly or via the drop down calendar. 

Start Time: The starting time for the event in 24-hour format.  May be entered directly or by the 
scroll controls 

Duration: This is the duration of the event and can range from 00:00:01 to 23:59:59. 

End Time: This is the end time for the event and is entered in 24-Hour clock notation. The minimum 
setting is 00:00:01 to maximum 23:59:59. 

Recur every (months): Sets the interval between recurring events from 1 to 100 months.   

Day: An event can also be set to trigger on the same date of the month e.g. 6th of the month 

No End Date: No end date the event will occur indefinitely. 

End After: Sets the number of occurrences of the event. 

End By: Sets the last possible date for an event.   

Client Name: The client’ name (Server only). 

 

4.3.5 Recognizing the Type of Event Icons 
The Timed Events screen uses special symbols to identify the different types of Event.  The 
symbols are shown in the table below. 

Transient Event 
 

Daily Event 
 

Weekly Event 
 

Monthly Event 
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4.3.6 Timed List Screen Examples. 
TIME 16:23:52 Next Switch 21/07/06 

16:25:03 

Active Switches 0 

Transient Switches 4 

Recurring Switches 3 
 

TYPE START TITLE DURATION CLIENT SRC DST STATUS 

 

20/07/06 

16:25:03 

Requires 
tieline 3 

00:10:00  Matrix 2 

M02s0008 

123 

Matrix 1 

M01d0006 

123 
 

 

20/07/06 

16:25:11 

Requires 
tieline 2 

00:10:00  Matrix 2 

M02s0005 

Matrix 1 

M01d0005 
 

 

20/07/06 

16:25:14 

Daily 
Event 1 

00:10:00  Matrix 2 

M02d0004 

123 

Matrix 2 

M02d0004 

123 
 

 

20/07/06 

16:25:24 

Transient 
event 1 

00:01:00  Matrix 1 

M01s0005 

123 

Matrix 1 

M01d0001 

123 
 

 

20/07/06 

16:25:30 

Monthly 
event 1 

00:10:00  Matrix 3 

M03s0004 

1 

Matrix 3 

M03d0001 

1 
 

 

20/07/06 

16:25:45 

Requires 
tieline 

00:10:00  Matrix 2 

M02s0003 

123 

Matrix 1 

M01d0002 

123 
 

 

20/07/06 

16:25:59 

Weekly 
event 1 

00:10:00  Matrix 1 

M01s0003 

123 

Matrix 1 

M01d0007 

123 
 

 

20/07/06 

16:25:14 

Daily 
event 1 

00:10:00  Matrix 2 

M02s0004 

123 

Matrix 2 

M02d0004 

123 
 

 

 

 

Transient event 

Daily recurring event 

Monthly recurring event 

Safe source: Default 
 

Customer name 
Free format text 

Holding the left mouse 
button down on an event 

displays additional 
information on the event 

The additional information displayed when the left mouse is held down 
on an event is 

• Safe source (Default, None or a Specific value for the event 

• Customer information 

• Free form text 

 
Brings up diagnostics display 
(ESC to close 
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TIME 16:26:04 Next Switch 21/07/06 
16:25:14 

Active Switches 5 

Transient Switches 0 

Recurring Switches 3 
 

TYPE START TITLE DURATION CLIENT SRC DST STATUS 

 

20/07/06 

16:25:03 

Requires 
tieline 3 

00:10:00  Matrix 2 

M02s0008 

123 

Matrix 1 

M01d0006 

123 
 

 

20/07/06 

16:25:11 

Requires 
tieline 2 

00:10:00  Matrix 2 

M02s0005 

Matrix 1 

M01d0005 
 

 

20/07/06 

16:25:14 

Daily 
Event 1 

00:10:00  Matrix 2 

M02d0004 

123 

Matrix 2 

M02d0004 

123 
 

 

20/07/06 

16:25:24 

Transient 
event 1 

00:01:00  Matrix 1 

M01s0005 

123 

Matrix 1 

M01d0001 

123 
 

 

20/07/06 

16:25:30 

Monthly 
event 1 

00:10:00  Matrix 3 

M03s0004 

1 

Matrix 3 

M03d0001 

1 
 

 

20/07/06 

16:25:45 

Requires 
tieline 

00:10:00  Matrix 2 

M02s0003 

123 

Matrix 1 

M01d0002 

123 
 

 

20/07/06 

16:25:59 

Weekly 
event 1 

00:10:00  Matrix 1 

M01s0003 

123 

Matrix 1 

M01d0007 

123 
 

 

20/07/06 

16:25:14 

Daily 
event 1 

00:10:00  Matrix 2 

M02s0004 

123 

Matrix 2 

M02d0004 

123 
 

 

 

 

 

This event had “NONE” set for the safe 
source; consequently this event is 
complete and not active 

The levels to be controlled are 
displayed below the source and 
destination 

This event failed to trigger.  The 
reason is that there are only two 
tielines from matrix 2 to matrix 1, so 
this event failed because there was 
not a tieline available. 
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TIME 16:26:38 Next Switch 21/07/06 
16:25:14 

Active Switches 4 

Transient Switches 0 

Recurring Switches 3 
 

TYPE START TITLE DURATION CLIENT SRC DST STATUS 

 

20/07/06 

16:25:03 

Requires 
tieline 3 

00:10:00  Matrix 2 

M02s0008 

123 

Matrix 1 

M01d0006 

123 
 

 

20/07/06 

16:25:11 

Requires 
tieline 2 

00:10:00  Matrix 2 

M02s0005 

Matrix 1 

M01d0005 
 

 

20/07/06 

16:25:14 

Daily 
Event 1 

00:10:00  Matrix 2 

M02d0004 

123 

Matrix 2 

M02d0004 

123 
 

 

20/07/06 

16:25:24 

Transient 
event 1 

00:01:00  Matrix 1 

M01s0005 

123 

Matrix 1 

M01d0001 

123 
 

 

20/07/06 

16:25:30 

Monthly 
event 1 

00:10:00  Matrix 3 

M03s0004 

1 

Matrix 3 

M03d0001 

1 
 

 

20/07/06 

16:25:45 

Requires 
tieline 

00:10:00  Matrix 2 

M02s0003 

123 

Matrix 1 

M01d0002 

123 
 

 

20/07/06 

16:25:59 

Weekly 
event 1 

00:10:00  Matrix 1 

M01s0003 

123 

Matrix 1 

M01d0007 

123 
 

 

20/07/06 

16:25:14 

Daily 
event 1 

00:10:00  Matrix 2 

M02s0004 

123 

Matrix 2 

M02d0004 

123 
 

 

7 events have reached their start time, 1 failed to start, 1 had “none” set for it’s safe source, so the 
status has changed to complete, 1 event has reached it’s stop time and successfully set the safe 
source, 4 events are currently active awaiting for the stop time. 

All events have now reached there stop time (none are active).  1 event failed to set its safe source. 

4 switches are 
now active. 

Successfully started 
and stopped. 
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TIME 16:50:40 Next Switch 21/07/06 
16:25:14 

Active Switches 0 

Transient Switches 0 

Recurring Switches 3 
 

TYPE START TITLE DURATION CLIENT SRC DST STATUS 

 

20/07/06 

16:25:03 

Requires 
tieline 3 

00:10:00  Matrix 2 

M02s0008 

123 

Matrix 1 

M01d0006 

123 
 

 

20/07/06 

16:25:11 

Requires 
tieline 2 

00:10:00  Matrix 2 

M02s0005 

Matrix 1 

M01d0005 
 

 

20/07/06 

16:25:14 

Daily 
Event 1 

00:10:00  Matrix 2 

M02d0004 

123 

Matrix 2 

M02d0004 

123 
 

 

20/07/06 

16:25:24 

Transient 
event 1 

00:01:00  Matrix 1 

M01s0005 

123 

Matrix 1 

M01d0001 

123 
 

 

20/07/06 

16:25:30 

Monthly 
event 1 

00:10:00  Matrix 3 

M03s0004 

1 

Matrix 3 

M03d0001 

1 
 

 

20/07/06 

16:25:45 

Requires 
tieline 

00:10:00  Matrix 2 

M02s0003 

123 

Matrix 1 

M01d0002 

123 
 

 

20/07/06 

16:25:59 

Weekly 
event 1 

00:10:00  Matrix 1 

M01s0003 

123 

Matrix 1 

M01d0007 

123 
 

 

20/07/06 

16:25:14 

Daily 
event 1 

00:10:00  Matrix 2 

M02s0004 

123 

Matrix 2 

M02d0004 

123 
 

The monthly event failed to set the safe source.  The reason is it is configured to use the default safe 
source, which is matrix 1 source 1.  However the destination is on matrix 3 and there was no available 
tielines from matrix 1 to matrix 3. 

 

 

 
Failed to set its safe source 
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4.3.7 Editing events 
Events can be edited by right clicking on the event you require to edit 
 

 
 
 
 
Replace: Will update the event details with your changes. 
Add:  Creates a new copy of the event with any changes made. 
Delete: Deletes the event. 
 
 

Replace will remain 
greyed out until a 
change is made 

Click on Event tab to reveal other 
editing tools 
Replace, Add, and Delete 
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4.3.8 CSV Files 
Comma Separated Values (CSV) type files may be imported and exported. 

The comma-separated values (or CSV) file format is a data format that has fields separated 
by a comma and records separated by new lines. Fields, that contains a comma, new line, 
or a double quote character, must be enclosed in double quotes. 

CSV files may be imported into most word processing and spreadsheet programs.  For 
example, opening the file in MS Word will show the text nature of the file, and while it can 
be edited, it’s not particularly intuitive (see the screenshot). 

Event Type, Start Date, Start Time, Duration, Title, Client, 
Destination Matrix, Destination, Source Matrix, Source, Safe Source 
Matrix, Safe Source Source, Levels, Customer, Text, Range Type, No of 
occurances, End Date, Every No (days/weeks/months), Day 
(weekly/monthly) 
 
Transient, 12/07/2006, 16:00:00, 00:01:00, Transient event 01, , 1, 1, 
1, 1, Default, , 12345           , ,  
Daily, 12/07/2006, 16:01:00, 00:10:00,  daily event 02, , 1, 2, 1, 1, 
1, 1, 12345           , , , NumOccur, 3, 11/07/2006, 2 
Monthly, 01/07/2006, 16:02:09, 00:30:00, monthly event, , 1, 4, 1, 1, 
Default, , 12345           , , , NumOccur, 2, 11/07/2006, 1, 11 
Weekly, 09/07/2007, 16:01:00, 02:30:00, weekly event, , 1, 3, 1, 1, 
Default, , 12345           , , , NumOccur, 2, 11/07/2006, 1, tuesday 

 

 

Opening the file in MS Excel arranges the data fields and records into a more simple and user-friendly 
spreadsheet view as shown in the cropped screenshot below.  The advantage of using external 
packages is that it allows for lots of data to be typed in very quickly, although error checking needs to be 
extra careful.  Also when saving the file, double-check that the file has a standard .csv extension. 

 

Exporting a CSV file 

To export a CSV file click the Schedule tab at the top left of the screen.  From the drop-
down menu select Export CSV then follow the usual save window. 
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4.3.8.1 Importing a CSV file 

To import a CSV file follow the path: - 

 Schedule > Export/Import > Import CSV 

Importing a CSV file does not replace current data but adds or appends to it.  To replace 
current data first clear the schedule before importing the CSV file. 

Notepad, most word processors and spreadsheet programs e.g. Excel will edit CSV files.  
When using an external editing program be sure to save as a CSV file and not the native 
file format of the application you are using. 

 

 

4.3.9 Events Logging 
An Event’s status and progress can be continuously monitored and logged.  The data can 
then be accessed and stored as a file by accessing the server options menu. 

Schedule Options Menu. 

Click on Schedule Tab at the top left of the screen, select Configuration, then Server 
Options.  This will open the Schedule Option screen.   

Schedule > Configuration  > Server Options > Schedule options 
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The first time the Event Logging option is checked, you will be asked to set up a log file.  
Thereafter when you check the Append to log file, logging info will be added to the log file.  
The name of the log file will then appear on the screen. 

 

 

 

 

To add to a  
Log File  
Click here 

To enable  
Event Logging 
Click here  

Click to apply 
changes 

Log name has been 
added 
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The following is an example of the log file for 5 daily events.  The table shows a summary of 
the events to assist with the log file. 

Event 
Title 

Start 
Time 

End 
Time 

Duration 
HH:MM 

D1 16:45 16:55 00:10 

D2 16:46 16:55 00:09 

D3 16:47 16:56 00:09 

D5 16:48 16:51 00:03 

D4 16:48:30 16:50:30 00:02 

D1
D2
D3

time

D5
D4

16
:4

5

16
:5

5

 

 

The Contents of Events Daily 01.log.  The log file stores date, time, and routing information. 

24/07/2006 16:45:00 Starting Daily Event "D1", Client "" 
  Created 24/07/2006 16:35:50 
  Source MCR Router (0) BARS (0), Destination MCR Router (0) MON 1 
(0), Levels 12345            
  Routed successfully 
 
24/07/2006 16:46:00 Starting Daily Event "D2", Client "" 
  Created 24/07/2006 16:36:53 
  Source MCR Router (0) BARS (0), Destination MCR Router (0) MON 2 
(1), Levels 12345            
  Routed successfully 
 
24/07/2006 16:47:00 Starting Daily Event "D3", Client "" 
  Created 24/07/2006 16:38:12 
  Source MCR Router (0) BARS (0), Destination MCR Router (0) MON 3 
(2), Levels 12345            
  Routed successfully 
 
24/07/2006 16:48:00 Starting Daily Event "D5", Client "" 
  Created 24/07/2006 16:40:14 
  Source MCR Router (0) BARS (0), Destination MCR Router (0) MON 6 
(5), Levels 12345            
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  Routed successfully 
 
24/07/2006 16:48:30 Starting Daily Event "D4", Client "" 
  Created 24/07/2006 16:39:15 
  Source MCR Router (0) BARS (0), Destination MCR Router (0) MON 5 
(4), Levels 12345            
  Routed successfully 
 
24/07/2006 16:50:30 Stopping Daily Event "D4", Client "" 
  Safe Source Default, Destination MCR Router (0) MON 5 (4) 
  Routed successfully 
 
24/07/2006 16:51:00 Stopping Daily Event "D5", Client "" 
  Safe Source Default, Destination MCR Router (0) MON 6 (5) 
  Routed successfully 
 
24/07/2006 16:55:00 Stopping Daily Event "D1", Client "" 
  Safe Source Default, Destination MCR Router (0) MON 1 (0) 
  Routed successfully 
 
24/07/2006 16:55:00 Stopping Daily Event "D2", Client "" 
  Safe Source Default, Destination MCR Router (0) MON 2 (1) 
  Routed successfully 
 
24/07/2006 16:56:00 Stopping Daily Event "D3", Client "" 
  Safe Source Default, Destination MCR Router (0) MON 3 (2) 
  Routed successfully 
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5 MCM Timed List Client 

5.1 Introduction 
The Timed List Client application works in association with the Timed List Server, which of 
course being a server must be started first.  As the screens, menus, and terminology are 
common for the server and client applications please refer to the timed list server 
description for detail.  Users may purchase multi-client licences according to their project 
needs. 

MCM Timed List Client Licences 

PR2-15T1-002 a 30-day evaluation or trial licence for 2 clients 

PR2-15F1-002 a full licence for 2 clients 

*Note that the last 3-digits indicates the number of clients 

 

Timed List 
Server

Licence
Manager

Database
Driver

other client
applications

Timed List 
Client n

General
Remote
Driver

other client
applications

Timed List 
Client 3

Timed List 
Client 2

Timed List 
Client 1

* number of clients is
 dependent on licence

 

 

Starting the MCM Timed List Client establishes communications with the licence Manager, 
Database Driver, General Remote Driver, and the Timed List Server. 
 



MCM User Guide  

 
 HU-MCM  169 

5.2 Starting the MCM Timed List Client 
 
The MCM Timed List Client can be started either from the desktop shortcuts that were created 
during installation or from the Start menu 

 
 

 
 

5.2.1 The Start-Up screen 
 

 

This is the Start-Up Screen. Clicking on the Schedule tab will offer several menu items.  The 
menu structure is shown below. 

The MCM Timed List Client 
can be started either from 
the desktop shortcuts that 
were created during 
installation or from the 
Windows Start menu as 
shown below 
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5.3 Schedule Menu 

 

5.3.1 Network Options 
The Network Options screen is shown below, and identifies the Server Interface Host and 
Port. 

 

 

 

5.3.2 Configuration Menu 
The Configuration Menu has two sub menus: the Client Options and Colour Scheme. 

5.3.2.1 The Clients Option Menu 
The Client Options Screen is shown below.  It allows the client name to be entered. 
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5.3.2.2 The Colour Scheme Menu 
The Colour Scheme menu allows the user to customise the colour of the screens and the 
font and font size used.  This may be useful from a company livery or Accessibility 
viewpoint. 

The Colour Scheme menu is shown below.  The screen is the same as the server menu.  
Please refer to section 4.1.2 for further details. 

 

 

As well as changing the colour scheme this menu allows the Font and Font Size to be 
changed.  Clicking the “Default” button can reverse all the changes. 

Enter 
Client 
Name 
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5.4 Linking to the Server 
Assuming that the Network Options: Host and Port have been defined, we can now 
connect to the server. 

5.4.1 Connecting to the Server 

 

From the Schedule Menu, click “Connect to Server”.  If this is successful, you will then need 
to log-in. 

 

5.4.2 Log In 
The Schedule Menu will have updated allowing two possible selections: Log In and 
Configuration. Select “Log In”. 

 

 

 

After the connection is established, a Login Screen will appear.  Companies operate 
different IT rules; logging onto a network usually requires some level of permission.  If in 
doubt consult your network administrator. 

Click to 
Connect to Server 

After the connection 
is established to the 
server, click on 
“Log In” 
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The MCM Timed List Client uses contextual menus.  After log-on is completed the menu 
tabs and their content will change. 

5.4.3 Events Menu 
 

 

 

 

 

Schedule

Clear

Append

Save

Export/Import

Colour scheme

Export CSV

Import CSV

Events

Add

Transitional

Daily

Weekly

Monthly

 

The menus contain all the necessary editing, file management, and importing/exporting 
tools.  A detailed discussion of these tools can be found in the server section. 

The Login Box, 
requires a User 
name and a 
Pasword 

After Log-on has been 
completed, the Events Menu tab 
will be added.  The Schedule 
menu items will also change. 
A tree diagram of the Schedule 
and Events tabs is shown below 
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5.4.4 Example 
In this example, there are two MCM Timed List Clients connected to the MCM Timed List 
Server.  The clients have been named Client 001 and 002.  There are three events in total: 
one entered directly into the server screen and one entered into each client 001 and 002. 

 

 

 

Timed
List Server

Licence
Manager

Database
Driver

other client
applications

Timed List 
Client 001

Timed List 
Client 002

General
Remote
Driver

other client
applications

 

 

 

 

Server/Client Event Title 

Server Network 001 

Client 001 Scotland 002 

Client 002 Wales 003 

 

 

The screenshot below shows the server and two clients: Client 001 and Client 002. The 
server shows the combined entries for the system. 
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The Server screen has an additional client column showing the name of the client 
originating the entry.  The entries can be edited on the server screen or the originating client 
screen.  Client screens can only view their own entries. 

Events are entered via the Events tab menu.  The process is identical to the server 
application.  Please refer to the server section for further details. 
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